## Contents

**Send Us Your Comments** ................................................................................................................... ix  
**Preface** ........................................................................................................................................................ xi  
  Audience for This Guide ................................................................. xi  
  How To Use This Guide ................................................................. xi  
  Documentation Accessibility ......................................................... xii  
  Other Information Sources .......................................................... xii  
  Do Not Use Database Tools to Modify Oracle Applications Data .......... xvii  
  About Oracle .................................................................................. xviii  

### Part I  Getting Started

1  **Introduction**  
  1.1 Oracle Sales Family Overview................................................................. 1-1  
  1.2 Oracle Collections Overview .................................................................... 1-2  
  1.2.1 Oracle Collections Features ................................................................. 1-2  
  1.3 New in this Release ........................................................................................ 1-3  
  1.3.1 New Views by Customer, Account or Delinquency .............................. 1-3  
  1.3.2 New Delinquency Tab for Expanded Collections Lifecycle Management .... 1-3  
  1.3.3 Collections Strategies for Optimized Collections Execution ............... 1-5  
  1.3.4 Collections Support for Oracle Leasing Contracts ............................. 1-6  
  1.3.5 New HTML Administration and Collections Functionality ................. 1-6  
  1.3.6 Collections Header and Profile ............................................................. 1-7  
  1.4 Obsolete in This Release ............................................................................ 1-7  
  1.5 Architecture and Technology .................................................................... 1-8  

2  **Before You Begin**  
  2.1 Related Documentation ............................................................................ 2-1  
  2.2 Installation Verification .............................................................................. 2-1
2.3 Application Procedures ................................................................. 2-3
2.3.1 Creating an FND User ................................................................. 2-3
2.3.2 Assigning AOL Responsibilities to the User ......................... 2-4
2.3.3 Setting User Application, Responsibility, or Site Level Profile Options 2-5
2.3.4 Creating an Employee ............................................................... 2-6
2.3.5 Creating a New Business Unit .................................................. 2-7
2.3.6 Creating a Customer ................................................................. 2-8
2.3.7 Creating a New Organization ................................................... 2-9
2.3.8 Creating a Workflow With Notifications ................................. 2-10
2.3.9 Defining Categories ................................................................. 2-11
2.3.10 Defining Products and Platforms .......................................... 2-12
2.3.11 Defining Unit of Measure Classes ........................................ 2-13
2.3.12 Defining Units of Measure ...................................................... 2-14
2.3.13 Creating a Supplier Contact .................................................. 2-15
2.3.14 Defining Sales Credit Types ................................................ 2-16
2.3.15 Setting Up Accounting Flexfields ........................................ 2-17
2.4 Oracle Collections Dependencies .............................................. 2-18
2.4.1 Mandatory Dependencies ...................................................... 2-18
2.4.2 Conditional Dependencies .................................................... 2-19
2.5 Dependency Verification .............................................................. 2-20

Part II Implementing Oracle Collections

3 Implementation Overview
3.1 Process Description ........................................................................ 3-1
3.2 Implementation Task Sequence .................................................... 3-1

4 Implementation Tasks for Oracle Collections
4.1 Implementing Oracle ERP Applications ....................................... 4-2
4.1.1 Aging Buckets ........................................................................ 4-2
4.1.2 Credit Card and EFT Payments ............................................. 4-3
4.2 Setting Up Collections Aging Buckets ........................................ 4-3
4.3 Setting Up Multiple Currencies .................................................. 4-4
4.4 Set Up Aging Bucket Filters ...................................................... 4-4
4.5 Creating Locations and Organizations.................................................................  4-5
4.6 Creating Employees ............................................................................................  4-5
4.6.1 With Full Oracle HRMS License ......................................................................  4-6
4.6.2 With Shared Oracle HRMS License.................................................................  4-6
4.7 Defining Resource Groups...................................................................................  4-6
4.8 Setting Up Employees as Users............................................................................  4-9
4.9 Importing Employees and Assigning Them Roles and Resource Groups..........  4-10
4.10 Setting Up CRM Foundation Notes.................................................................  4-13
4.11 Setting Up CRM Foundation Interaction History .............................................  4-14
4.12 Setting Up CRM Foundation Tasks ...................................................................  4-15
4.13 Setting Up CRM Foundation Calendar.............................................................  4-15
4.14 Setting Up CRM Foundation Fulfillment .........................................................  4-15
4.15 Setting Up CRM Foundation Territory Management .......................................  4-16
4.15.1 Setting Up Territories ....................................................................................  4-16
4.15.2 Running Concurrent Programs for Territory Assignment .........................  4-18
4.16 Setting Up Oracle Universal Work Queue ......................................................  4-18
4.17 Setting Up Oracle iPayment................................................................................  4-19
4.18 Setting Up Collections Campaigns in Oracle Marketing Online ....................  4-19
4.19 Setting Up Scripting ..........................................................................................  4-19
4.20 Enabling Interaction Center...............................................................................  4-19
4.21 Setting Up Campaign Assignment And Wrap-up Administration .................  4-19
4.22 Enabling Oracle iReceivables............................................................................  4-20
4.23 Set Up Scoring....................................................................................................  4-20
4.23.1 Create Scoring Component Types .................................................................  4-20
4.23.2 Create New Scoring Engines .......................................................................  4-21
4.23.3 Add Components to Scoring Engines ..........................................................  4-22
4.23.4 Configuring Scoring Engine Components ...................................................  4-24
4.23.5 Entering Parameters for a Scoring Component Function ............................  4-25
4.23.6 Using a Scoring Engine to Assign Delinquency Status ...............................  4-26
4.23.7 Creating or Updating a Scoring Filter ..........................................................  4-27
4.24 Set Up Strategies..............................................................................................  4-28
4.24.1 Creating a Work Item Template ....................................................................  4-28
4.24.2 Creating a Strategy Template ......................................................................  4-30
4.24.3 Adding Work Items to a Strategy Template ...............................................  4-31
4.24.4 Creating or Updating a Strategy Filter ..........................................................  4-32
Part III  Post Implementation Tasks

5  Verifying the Implementation

5.1  Use the Diagnostic Tests
5.2  Implementation Verification Tasks for Mandatory Components
  5.2.1  Create Accounts
  5.2.2  Create Invoices
  5.2.3  Create Delinquencies
  5.2.4  Verify Delinquencies
  5.2.5  Dispute an Invoice
  5.2.6  Record a Promise to Pay
  5.2.7  Process a Credit Card Payment
  5.2.8  Process a Bank EFT Payment
  5.2.9  Process the Collections Activities
  5.2.10  Verify Payment Processing
  5.2.11  Verify the Collector’s Actions
  5.2.12  Verify Universal Work Queue Navigation
  5.2.13  Verify Query Navigation
  5.2.14  Verify Interaction Tracking
5.3  Implementation Verification Tasks for Optional Components
  5.3.1  Create Discoverer Workbooks
  5.3.2  Create Collections Campaign
  5.3.3  Create Collections Script
  5.3.4  Verify Advanced Inbound
  5.3.5  Verify Advanced Outbound
  5.3.6  Verify E-mails
  5.3.7  Verify Inbound and Outbound Flows
Part IV  Appendixes

A.1  Table of Lookups .......................................................... A-2
A.2  Table of Lookups .......................................................... A-6
Oracle Corporation welcomes your comments and suggestions on the quality and usefulness of this document. Your input is an important part of the information used for revision.

- Did you find any errors?
- Is the information clearly presented?
- Do you need more information? If so, where?
- Are the examples correct? Do you need more examples?
- What features did you like most?

If you find any errors or have any other suggestions for improvement, please indicate the document title and part number, and the chapter, section, and page number (if available). You can send comments to us via postal service:

Oracle Corporation
Sales Content Development Manager
500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

If you would like a reply, please give your name, address, telephone number, and (optionally) electronic mail address.

If you have problems with the software, please contact your local Oracle Support Services.
Preface

Audience for This Guide

Welcome to Release 11i of the Oracle Collections Implementation Guide.

This guide assumes you have a working knowledge of the following:

- The principles and customary practices of your business area.
- Oracle Collections
  If you have never used Oracle Collections, Oracle suggests you attend one or more of the Oracle Collections training classes available through Oracle University.
- The Oracle Applications graphical user interface.
  To learn more about the Oracle Applications graphical user interface, read the Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications product information.

How To Use This Guide

This guide contains the information you need to implement Oracle Collections.

- Chapter 1 provides an overview of the Oracle Sales family of products as well as an overview of Oracle Collections and application features.
- Chapter 2 discusses dependencies for the application.
- Chapter 3 provides an overview of the implementation process and the sequence of tasks.
Chapter 4 provides detail instructions for each implementation step and lists the steps in the order in which they should be performed.

Chapter 5 discusses how to verify that your implementation is successful.

**Documentation Accessibility**

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Standards will continue to evolve over time, and Oracle Corporation is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For additional information, visit the Oracle Accessibility Program Web site at [http://www.oracle.com/accessibility/](http://www.oracle.com/accessibility/).

**Accessibility of Code Examples in Documentation**  JAWS, a Windows screen reader, may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, JAWS may not always read a line of text that consists solely of a bracket or brace.

**Accessibility of Links to External Web Sites in Documentation**  This documentation may contain links to Web sites of other companies or organizations that Oracle Corporation does not own or control. Oracle Corporation neither evaluates nor makes any representations regarding the accessibility of these Web sites.

**Other Information Sources**

You can choose from many sources of information, including online documentation, training, and support services, to increase your knowledge and understanding of Oracle Collections.

If this guide refers you to other Oracle Applications documentation, use only the Release 11i versions of those guides.
**Online Documentation**

All Oracle Applications documentation is available online (HTML or PDF). Online help patches are available on MetaLink.

**Related Documentation**

Oracle Collections shares business and setup information with other Oracle Applications products. Therefore, you may want to refer to other product documentation when you set up and use Oracle Collections.

You can read the documents online by choosing Library from the expandable menu on your HTML help window, by reading from the Oracle Applications Document Library CD included in your media pack, or by using a Web browser with a URL that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at [http://oraclestore.oracle.com](http://oraclestore.oracle.com).

**Documents Related to All Products**

**Oracle Applications User’s Guide**

This guide explains how to enter data, query, run reports, and navigate using the graphical user interface (GUI) available with this release of Oracle Collections (and any other Oracle Applications products). This guide also includes information on setting user profiles, as well as running and reviewing reports and concurrent processes.

You can access this user’s guide online by choosing “Getting Started with Oracle Applications” from any Oracle Applications help file.

**Documents Related to This Product**

Many of the implementation tasks in this guide refer to other documents.

**Installation and System Administration**

**Oracle Applications Concepts**

This guide provides an introduction to the concepts, features, technology stack, architecture, and terminology for Oracle Applications Release 11i. It provides a useful first book to read before an installation of Oracle Applications. This guide also introduces the concepts behind Applications-wide features such as Business Intelligence (BIS), languages and character sets, and Self-Service Web Applications.
Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle Applications products. In Release 11i, much of the installation process is handled using Oracle Rapid Install, which minimizes the time to install Oracle Applications, the Oracle8 technology stack, and the Oracle8i Server technology stack by automating many of the required steps. This guide contains instructions for using Oracle Rapid Install and lists the tasks you need to perform to finish your installation. You should use this guide in conjunction with individual product user’s guides and implementation guides.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or Release 11.0 products to Release 11i. This guide describes the upgrade process and lists database and product-specific upgrade tasks. You must be either at Release 10.7 (NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and others. It contains how-to steps, screenshots, and other information that you need to run the AD utilities. This guide also provides information on maintaining the Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications System Administrator. It contains information on how to define security, customize menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications development staff. It describes the Oracle Application Object Library components needed to implement the Oracle Applications user interface described in the Oracle Applications User Interface Standards for Forms-Based Products. It also provides
information to help you build your custom Oracle Forms Developer 6i forms so that they integrate with Oracle Applications.

**Oracle Applications User Interface Standards for Forms-Based Products**
This guide contains the user interface (UI) standards followed by the Oracle Applications development staff. It describes the UI for the Oracle Applications products and how to apply this UI to the design of an application built by using Oracle Forms.

**Other Implementation Documentation**

**Multiple Reporting Currencies in Oracle Applications**
If you use the Multiple Reporting Currencies feature to record transactions in more than one currency, use this manual before implementing Oracle Collections. This manual details additional steps and setup considerations for implementing Oracle Collections with this feature.

**Multiple Organizations in Oracle Applications**
This guide describes how to set up and use Oracle Collections with Oracle Applications’ Multiple Organization support feature, so you can define and support different organization structures when running a single installation of Oracle Collections.

**Oracle Workflow Guide**
This guide explains how to define new workflow business processes as well as customize existing Oracle Applications-embedded workflow processes. You also use this guide to complete the setup steps necessary for any Oracle Applications product that includes workflow-enabled processes.

**Oracle Applications Flexfields Guide**
This guide provides flexfields planning, setup and reference information for the Oracle Collections implementation team, as well as for users responsible for the ongoing maintenance of Oracle Applications product data. This manual also provides information on creating custom reports on flexfields data.

**Oracle eTechnical Reference Manuals**
Each eTechnical Reference Manual (eTRM) contains database diagrams and a detailed description of database tables, forms, reports, and programs for a specific Oracle Applications product. This information helps you convert data from your
existing applications, integrate Oracle Applications data with non-Oracle applications, and write custom reports for Oracle Applications products. Oracle eTRM is available on Metalink

**Oracle Manufacturing APIs and Open Interfaces Manual**
This manual contains up-to-date information about integrating with other Oracle Manufacturing applications and with your other systems. This documentation includes APIs and open interfaces found in Oracle Manufacturing.

**Oracle Order Management Suite APIs and Open Interfaces Manual**
This manual contains up-to-date information about integrating with other Oracle Manufacturing applications and with your other systems. This documentation includes APIs and open interfaces found in Oracle Order Management Suite.

**Oracle Applications Message Reference Manual**
This manual describes Oracle Applications messages. This manual is available in HTML format on the documentation CD-ROM for Release 11i.

**Oracle CRM Application Foundation Implementation Guide**
Many CRM products use components from CRM Application Foundation. Use this guide to correctly implement CRM Application Foundation.

**Training and Support**

**Training**
Oracle offers training courses to help you and your staff master Oracle Collections and reach full productivity quickly. You have a choice of educational environments. You can attend courses offered by Oracle University at any one of our many Education Centers, you can arrange for our trainers to teach at your facility, or you can use Oracle Learning Network (OLN), Oracle University’s online education utility. In addition, Oracle training professionals can tailor standard courses or develop custom courses to meet your needs. For example, you may want to use your organization’s structure, terminology, and data as examples in a customized training session delivered at your own facility.

**Support**
From on-site support to central support, our team of experienced professionals provides the help and information you need to keep Oracle Collections working for you. This team includes your Technical Representative, Account Manager, and
Oracle’s large staff of consultants and support specialists with expertise in your business area, managing an Oracle8i server, and your hardware and software environment.

**OracleMetaLink**
OracleMetaLink is your self-service support connection with web, telephone menu, and e-mail alternatives. Oracle supplies these technologies for your convenience, available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain information and advice from technical libraries and forums, download patches, download the latest documentation, look at bug details, and create or update TARs. To use MetaLink, register at (http://metalink.oracle.com).

**Alerts:** You should check OracleMetaLink alerts before you begin to install or upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: Technical Libraries/ERP Applications/Applications Installation and Upgrade/Alerts.

**Self-Service Toolkit:** You may also find information by navigating to the Self-Service Toolkit page as follows: Technical Libraries/ERP Applications/Applications Installation and Upgrade.

---

**Do Not Use Database Tools to Modify Oracle Applications Data**

*Oracle STRONGLY RECOMMENDS that you never use SQL*Plus®, Oracle Data Browser, database triggers, or any other tool to modify Oracle Applications data unless otherwise instructed.*

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using Oracle Applications can update many tables at once. But when you modify Oracle Applications data using anything other than Oracle Applications, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications automatically checks that your changes are valid. Oracle Applications also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to
track who has changed your information because SQL*Plus and other database
tools do not keep a record of changes.

About Oracle

Oracle Corporation develops and markets an integrated line of software products
for database management, applications development, decision support, and office
automation, as well as Oracle Applications, an integrated suite of more than 160
software modules for financial management, supply chain management,
manufacturing, project systems, human resources and customer relationship
management.

Oracle products are available for mainframes, minicomputers, personal computers,
network computers and personal digital assistants, allowing organizations to
integrate different computers, different operating systems, different networks, and
even different database management systems, into a single, unified computing and
information resource.

Oracle is the world’s leading supplier of software for information management, and
the world’s second largest software company. Oracle offers its database, tools, and
applications products, along with related consulting, education, and support
services, in over 145 countries around the world.
This part contains the following chapters:

- Chapter 1, "Introduction"
- Chapter 2, "Before You Begin"
This chapter provides an introduction to and overview of Oracle Collections and includes the following topics:

- Section 1.1, "Oracle Sales Family Overview"
- Section 1.2, "Oracle Collections Overview"
- Section 1.3, "New in this Release"
- Section 1.4, "Obsolete in This Release"
- Section 1.5, "Architecture and Technology"

1.1 Oracle Sales Family Overview

Oracle Sales is a comprehensive family of tightly integrated applications to maximize sales, increase selling effectiveness, and align sales behavior to corporate objectives across all sales channels. Oracle Sales enables the field sales force, telesales teams, resellers, partners, and web storefronts to collaborate in closing more business together as one sales team. Oracle Sales enables companies to implement flexible, customer-centric processes, not only to sell effectively and increase revenue, but also to create and enhance long-term customer relationships.

The Oracle Sales Family includes:

- Sales Online
- Field Sales Laptop/Palm/Wireless
- TeleSales
- Incentive Compensation
- Partners Online
1.2 Oracle Collections Overview

Collections agents and their managers can use Oracle Collections to plan and execute collections strategies that accomplish the following:

- Identify delinquent customers
- Obtain a snapshot of the customer’s past payment history
- Support standard methods of payments that will quickly resolve the delinquent situation

1.2.1 Oracle Collections Features

The following features are available in Oracle Collections:

- Financial account and transaction management
- Historical views of past delinquencies, payments, disputes, dunning, and interactions
- Processing of payments by credit card or electronic funds transfer
- Processing promises to pay
- Processing of payment disputes and payment reversals
- Integration with Oracle iPayment for real-time credit card and bank EFT authorization
- Automated customer scoring and collections strategy process
- Coordination of payments, debits, disputes, and reversals through Oracle iPayment and Oracle Accounts Receivable
- Tracking of delinquencies, strategy work items, and broken promises in Universal Work Queue
- Reports that track collection efforts
- Tracking of cases of delinquent payments associated to lease contracts (used in conjunction with Oracle Lease Management)
1.3 New in this Release

The following new features have been added to Oracle Collections in this release.

- Section 1.3.1, "New Views by Customer, Account or Delinquency"
- Section 1.3.2, "New Delinquency Tab for Expanded Collections Lifecycle Management"
- Section 1.3.3, "Collections Strategies for Optimized Collections Execution"
- Section 1.3.4, "Collections Support for Oracle Leasing Contracts"
- Section 1.3.5, "New HTML Administration and Collections Functionality"
- Section 1.3.6, "Collections Header and Profile"

1.3.1 New Views by Customer, Account or Delinquency

The Collections header now supports the ability for a collector to view information hierarchically, by the entire customer, by selected accounts or all accounts, or by specific delinquencies. This allows users to more quickly understand issues surrounding a non-payment problem: Is this customer delinquent in all accounts, or is there an issue relating to a specific delinquent payment? Collections agents use this information to work more effectively with their customers to get payments faster.

1.3.2 New Delinquency Tab for Expanded Collections Lifecycle Management

The Delinquency Tab provides a view of all of a customer's delinquencies. Delinquencies are identified through a concurrent program verifying payments and disputes in Oracle Receivables. However, as delinquencies move through the collections lifecycle, their status may change repeatedly over time. Complicated delinquencies can involve changing credit or payment terms, bringing suit to get payment, repossessing and reselling assets to cure delinquencies, write off of assets, or customer bankruptcy. The Delinquency Tab, in conjunction with various HTML interfaces used by collections specialists and managers, supports these latter stage delinquency processes.

1.3.2.1 Bankruptcy

When a delinquent customer informs the collector that they cannot pay because they are planning to declare bankruptcy, the collector has to quickly gather initial information about the debtor's claim, attorneys involved, and other legal information. Once initial information is gathered, and a litigation or bankruptcy
New in this Release

specialist manages the delinquency through the legal phase. Additionally, in some implementations automated processes begin to prevent additional collections calls, all related accounts are flagged with the bankruptcy status, and invoicing is turned off.

1.3.2.2 Litigation
When a delinquent customer refuses to pay or is markedly slow to resolve a delinquency, collections organizations can try to bring suit to obtain payment on some or all debt. The collector initiates the litigation process, captures initial data, and documents alternatives explored. The system then moves the delinquency to a litigation specialist who may involve corporate or external counsel. And since judgments affect the ability to obtain payment, final status is tracked.

1.3.2.3 Repossession
Equipment or other assets owned or leased by a customer can be repossessed as part of the collections process. The collections agent reviews the delinquency, ensures all legal notifications and procedures are completed, and contacts the repossession agent. This can set the stage for Asset Remarketing when Oracle Collections is used with Oracle Lease Management.

1.3.2.4 Write Off
At some point in the collections process, a determination may be made to write off some or all of a delinquency. The collector initiates the write off process by recommending which assets should be written off, documenting appropriate asset information, and forwarding through the approval process.

1.3.2.5 Third Party Assignment
As the delinquency progresses through the collections process, collectors often assign them to various internal and external resources. Legal organizations, repossession agencies, billing managers, credit managers, and other resources will be assigned as third parties to complete some tasks in the collections process.

1.3.2.6 Special Requests
Requests to place customers or accounts on credit hold or service hold are also supported when Oracle Collections is used with Oracle Lease Management. These processes are initiated by the collectors.
1.3.3 Collections Strategies for Optimized Collections Execution

Oracle Collections enhances the Dunning Plan and Scoring Engine by leveraging a new collections strategies feature to provide sophisticated collections strategy management for collectors, managers, and various collections specialists. Best Practices Collections Strategies can be created to determine appropriate collections work items based on customer and delinquency scores and ranks, to determine the best agent to handle the task, and to ensure all collections activities are scheduled and completed. Strategies can support both delinquent and pre-delinquent collections plans. Additionally, strategy checklists can be created. Checklists help users track all steps required to carry out specific business processes. They can be mirror images of a strategy or they can include additional steps to which users refer.

1.3.3.1 Collections Strategy Management

The Collections Strategy feature allows a manager to create a collection strategy template once, designate one or more required work items used to execute the strategy, apply scoring and business rules, and then re-use the template for multiple delinquencies having similar characteristics. Individual work item templates are also created once, configured to run automatically or manually, and used by multiple strategy templates.

1.3.3.2 Collections Execution

The Collections Strategy feature creates and assigns collections work items to collectors, collections specialists (bankruptcy, litigation, write off, repossession), and senior collections agents and managers. Strategy work items appear on a user’s Universal Work Queue in a separate node. A strategy also creates automated work items which do not require agent intervention. Agents make calls, send letters, and perform other collections activities while focusing on only those delinquencies that require their attention. Managers and specialists focus on collections issues that agents cannot resolve or that need other team members to work on. The Collections Strategy system tracks each work item and its status to ensure all are executed in a timely manner.

1.3.3.3 Enhanced Scoring

The Collections scoring engine is enhanced to support initiating, assigning, and tracking strategies based on the customer, invoice, or delinquency collections score. Seeded scoring components as well as user-created scoring components are used to rank the customer and then the system determines what strategy and what resources are required. Additionally, Scoring can also be used in Dunning and Collections Campaigns.
1.3.4 Collections Support for Oracle Leasing Contracts

Oracle Collections provides the collection component for Oracle Lease Management, an Oracle Contracts application that meets the needs of lessors throughout the entire lifecycle of a lease. Oracle Collections provides standard collections components for lease management including support for management of cases and delinquencies associated to lease contracts, payment processing, collections strategies and scoring, notes, and task assignments.

1.3.4.1 Case Management

A case is a group of contracts for a leasing customer. The Case Tab displays all of the cases related to the customer identified in the header and includes information for that case, case details, contracts, asset information, strategies, and third party vendor program information. Collectors can also process payments against cases.

1.3.4.2 Leasing Contracts

Oracle Collections provides a Contracts Tab with summary and detail information about the leasing contract. Collectors require the ability to review contract terms, understand contact rules, and view assets. Collectors can also process payments against a lease contract.

1.3.4.3 Vendor Cure and Repurchase

Lease contracts cover special provisions for third party vendors when a customer’s lease becomes delinquent. As per the vendor program, collectors must sometime contact the vendor to obtain payment and to process the delinquency. And refunds are sometimes provided back to the vendor should the customer eventually pay. See the Oracle Lease Management User Guide for more information.

1.3.4.4 Open Interfaces

Oracle Collections supports two types of external interfaces for lease management: credit bureau reporting and third party assignments. Collectors may send a delinquent customer a notice of intent to report to a credit bureau unless payments are received. If payments are not received, then the collector reports the delinquent account to the credit bureau. The collections process also requires that customer and lease case information be transferred to third party organizations.

1.3.5 New HTML Administration and Collections Functionality

Oracle Collections adds more HTML interfaces to support additional administrative and managerial functionality as well as provide functionality for the various
collections specialists who are responsible for resolving the later-stage delinquencies but do not work in an interaction center.

### 1.3.5.1 Management
Oracle Collections provides an HTML interface to perform all administrative and managerial collections work. Managers create new tasks, new strategy templates, new scoring components, assign score ranges, and run team and campaign reports. Additionally they may review and approve or disapprove credit and service hold requests, write-off or litigation decisions, progress of strategies, and other actions relating to their team’s customer delinquencies.

### 1.3.5.2 Collections Specialists
From the HTML interface, collections specialists handle delinquencies once they reach the later stage in the collections lifecycle. Specialists track or resolve bankruptcy, litigation, write off, repossession, third party assignments, vendor cure and repurchase, and other functions. Additionally, the interface provides views into the customer, supports payment processing, and allows review and modification to strategies.

### 1.3.6 Collections Header and Profile
Oracle Collections enhances the collector experience by providing additional collections information on both the Collections Header and the Profile Tab. In particular, various fields were added on the Header including the Status field which provides the overall status of that customer. There is a hierarchy associated to the available statuses so that the most critical status for that customer (and each customer may have several delinquencies in various stages) is displayed. If a customer is in bankruptcy, for instance, that status applies to all accounts for that customer.

### 1.4 Obsolete in This Release
The following table shows profile options that are replaced or obsoleted:

<table>
<thead>
<tr>
<th>Table 1–1  Profile Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Old Option</strong></td>
</tr>
<tr>
<td>IEX: Default Exchange Rate Type</td>
</tr>
<tr>
<td>IEX: Queue: Delinquencies</td>
</tr>
</tbody>
</table>
### 1.5 Architecture and Technology

Oracle Collections is built on the following technology stack:

- Dataserver (EE + InterMedia all options + Spatial), version 8.1.7.3
- WorkFlow, version 2.6
- InterMedia, version 8.1.7.2
- Client side RSFs, version 8.0.6
- Forms, version 6.0.8.18 (Patch 9)
- Reports for use with Concurrent Mgr., version 6.0.8.8.3
- WebDB, version 2.2.2.1
- EWT, version 3.4
- Perspective for Java, version 1.1 build 325
- JInitiator, version 1.1.8.16
- MS Internet Explorer, version 5.5 or later. This is the recommended browser for all HTML-based applications.
- Netscape Navigator, version 4.5
Before You Begin

This chapter provides an overview of what you need to have installed, implemented, and verified before implementing Oracle Collections. Topics include:

- **Section 2.1, "Related Documentation"**
- **Section 2.2, "Installation Verification"**
- **Section 2.4, "Oracle Collections Dependencies"**
- **Section 2.5, "Dependency Verification"**

### 2.1 Related Documentation

Listing of relevant courses, documentation, OSS, OTN, MetaLink, AppsNet, and other implementation resources related to the product

### 2.2 Installation Verification

Before attempting to run CRM applications, first verify that you can perform the tasks outlined in the following table. The listed tasks are generic tasks that are typical of all users of the Oracle E-Business Suite. Depending on your business processes, and the modules that you are installing, not every listed task is applicable to your installation.

The following table describes the non-CRM application module tasks that need to be performed, and which CRM modules require the completion of the task before implementation.
### Table 2–1  Application Dependency Checklist

<table>
<thead>
<tr>
<th>Application</th>
<th>Task</th>
<th>CRM Module</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Object Library</td>
<td>1. Creating an FND User</td>
<td>Resource Manager, Territory Manager, Task, HTML Calendar, Forms-based Calendar, Notes, Business Rule Monitor, Escalation Manager, Assignment Manager</td>
</tr>
<tr>
<td></td>
<td>2. Assigning AOL Responsibilities to the User</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Setting User Application, Responsibility, or Site Level Profile Options</td>
<td></td>
</tr>
<tr>
<td>Oracle Human Resources</td>
<td>Creating an Employee</td>
<td>Resource Manager, Task Manager, Business Rule Monitor, Escalation Manager</td>
</tr>
<tr>
<td>Oracle Human Resources</td>
<td>Creating a New Business Unit</td>
<td>Resource Manager</td>
</tr>
<tr>
<td>Oracle Receivables</td>
<td>1. Creating a Customer</td>
<td>Resource Manager</td>
</tr>
<tr>
<td></td>
<td>2. Creating a New Organization</td>
<td></td>
</tr>
<tr>
<td>Oracle Workflow</td>
<td>Creating a Workflow With Notifications</td>
<td>Resource Manager, Task Manager, HTML Calendar, Notes, Business Rule Monitor, Escalation Manager</td>
</tr>
<tr>
<td>Oracle Inventory</td>
<td>1. Defining Categories</td>
<td>Resource Manager</td>
</tr>
<tr>
<td></td>
<td>2. Defining Products and Platforms</td>
<td>Task Manager, Assignment Manager</td>
</tr>
<tr>
<td></td>
<td>3. Defining Unit of Measure Classes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4. Defining Units of Measure</td>
<td></td>
</tr>
<tr>
<td>Oracle Purchasing</td>
<td>Creating a Supplier Contact</td>
<td>Resource Manager</td>
</tr>
</tbody>
</table>
2.3 Application Procedures

You must be able to complete each of the following non-CRM tasks successfully for your CRM applications to work properly. If you are unable to complete a task successfully, then correct the problem before continuing.

2.3.1 Creating an FND User

Perform the following steps to create a FND user in the Application Object Library.

Reference


Prerequisites

None

Responsibility

System Administrator

Navigation

Navigate to Security > User > Define.

Steps

1. In the User window, enter a new user name in the User Name field.
2. Enter a password in the Password field.
3. Re-enter the password for verification.
4. Select the employee’s name from the list of Values (LOV) in the Person Field.
5. In the Responsibilities sub-tab, select the CRM HTML Administration responsibility from the drop-down list of values.

6. Save the new user.

To verify that the user setup is successful, perform the following steps:

1. Login to your Personal Home Page as the newly created user.
2. Enter your new password when prompted.

You should now be able to access the Personal Home Page for this user.

---

**Note:** For this user to have access to HTML applications, you must set additional profile options as detailed in the Implementing Oracle CRM Application Foundation manual.

---

### 2.3.2 Assigning AOL Responsibilities to the User

A responsibility defines an application user’s current privileges while working with Oracle Applications. When an application user signs on, they select a responsibility that grants certain privileges, specifically:

- The functions that the user may access. Functions are determined by the menu assigned to the responsibility.
- The concurrent programs, such as reports, that the user may run.
- The application database accounts to which forms, concurrent programs, and reports connect.

You cannot delete a responsibility because this information helps to provide an audit trail. You can deactivate a user’s responsibility at any time by setting the End Date to the current date. If you wish to reactivate the responsibility for the user, change the End Date to a date after the current date, or clear the End Date.

After creating the FND User, perform the following steps to assign the user AOL responsibilities.

**Reference**

*Managing People Using Oracle HRMS (US),* See Chapter 1, Employee Management

**Prerequisites**

None
Responsibility
System Administrator

Navigation
Navigate to Security > User > Define.

Steps
1. With the user information populated in the window, select the Responsibility field in the Responsibilities tab.
2. Select the necessary responsibility from the List of Values (LOV).
3. Define the Effective dates.
4. Save your work.

2.3.3 Setting User Application, Responsibility, or Site Level Profile Options

A user profile is a set of changeable options that affect the way your application looks and behaves. As System Administrator, you control how Oracle Applications operate by setting user profile options to the values you want. You can set user profile options at four different levels: site, application, responsibility, and user.

After creating the FND User, perform the following steps to set profile options.

Reference
Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites
None

Responsibility
System Administrator

Navigation
Navigate to Security > Profile > System.

Steps
1. In the Find System Profile Values window, Enter the profile option you want to set and click Find.

Before You Begin 2-5
The System Profile Values window opens with the profile option you searched for.

2. Set at least one of the following:
   a. Set the Site value.
      This field displays the current value, if set, for all users at the installation site.
   b. Set the Application value.
      This field displays the current value, if set, for all users working under responsibilities owned by the application identified in the Find Profile Values block.
   c. Set the Responsibility value.
      This field displays the current value, if set, for all users working under the responsibility identified in the Find Profile Values block.
   d. Set the User value.
      This field displays the current value, if set, for the application user identified in the Find Profile Values block.

   You should set site-level default values for any required options after installation of an application. If you do not assign a particular profile option at any of the four levels, that option does not have a default value and may cause errors when you use forms, run reports, or run concurrent requests.

3. Save your work.

2.3.4 Creating an Employee

To successfully run most of the CRM products, you must first create employee resources within the ERP Human Resource Management System (HRMS) application. Perform the following steps to define an employee for minimal functionality.

---

**Note:** If Oracle HRMS is not installed, then you must enter a new employee using the Enter Person form by navigating to Resource Manager > Maintain Employee > Employee.
Reference

Managing People Using Oracle HRMS (US), See Chapter 1, Employee Management

Prerequisites

None

Responsibility

US HRMS Manager or US Super HRMS Manager

Navigation

Navigate to People > Enter and Maintain.

Steps

1. Click New in the find window.
   The People window opens.
2. Enter the following employee information in the appropriate form fields:
   - Last Name
   - First Name
   - Title
3. Select the person’s gender from the drop-down list.
4. Select Employee from the type drop-down list.
5. Enter the person’s social security number.
6. Save your work.

2.3.5 Creating a New Business Unit

A Business Group is a special class of organization. Every Business Group can have its own set of default values, with its own internal organizations, grades, jobs, positions, payrolls, employees, applicants, compensations and benefits.

Organizations are the basic work structure of any enterprise. They usually represent the functional, management, or reporting groups which exist within a Business Group. Perform the following steps to create a new business unit.
Reference

Oracle Applications System Administrator’s Guide, See Chapter 2, Managing Oracle
Applications Security

Prerequisites
None

Responsibility
US HRMS Manager or US Super HRMS Manager

Navigation
Navigate to Work Structures > Organization > Description.

Steps
1. Click New in the Find Organization window.
2. Enter the name for the Organization
3. Select Business Unit from the list of values (LOV) in the Type field.
   The current date populates the From Date field.
4. Enter the Organization location details from the LOV.
5. Save your work.
6. In the Organization Classification region, select the classification from the LOV.
7. Select the Enabled check box.
8. Save your work.
9. Click Others for additional information on the classification you selected.
10. Save your work.

2.3.6 Creating a Customer

Perform the following steps to create an new customer, with an address and contact
information in the Oracle ERP Accounts Receivables application.

Reference

Oracle Receivables User’s Guide, See Chapter 3, Customers
Prerequisites
None

Responsibility
Receivables Manager

Navigation
Navigate to Customers > Standard.

Steps
1. In the Find/Enter Customers window, select Person from the Customer Type drop-down list.
2. Enter the name of the customer in the Name column.
3. Click Find to ascertain if the customer already exists.
   As this customer does not exist, the New button is enabled in the Decisions window.
4. Click New.
   The Customer-Standard window opens.
5. On the Address tab, click New to create a new address.
   The Customer Addresses window opens.
6. Fill in the necessary information. Yellow fields are mandatory.
7. On the Business Purpose tab, fill in the Usage, Location and select the Primary check box. For example:
   - Usage: Marketing
   - Location: 6op9
   - Primary: Yes
8. On the Contacts: Telephones tab, enter a new contact and phone number.
9. Save your work.

Verify the Information
To verify that the process worked properly, perform the following steps.
1. Open the Customer-Standard window again.
2. Enter the company name you entered above.
3. Click Find to query for the record you created in the Match Results window.
4. If the record is found, click the Contacts: Telephone tab.
5. Place the cursor in the Last Name field
6. From the menu, select View > Query by Example > Enter.
7. Enter the contacts last name as the search criteria.
8. Click View > Query by Example > Run.
   If the record for your contact name populates in the form, then you have successfully created a customer with an address and a contact person for the customer.

2.3.7 Creating a New Organization

Perform the following steps to create a new organization, with an address and contact information in the Oracle ERP Accounts Receivables application.

Reference
Oracle Receivables User’s Guide, See Chapter 3, Customers

Prerequisites
None

Responsibility
Receivables Manager

Navigation
Navigate to Customers > Standards.

Steps
1. In the Find/Enter Customer window, select Organization from the Customer Type drop-down list.
2. Enter the name of a test corporation in the Name field.
3. Click Find to ascertain if the customer already exists.
   As this customer does not exist, the New button is enabled.
4. Click **New**.
   The Customer-Standard window opens.

5. On the Address tab, click **New** to create a new address.
   The Customer Addresses window opens displaying the same business purpose table as on the first tab.

6. Fill in the necessary information. Yellow fields are mandatory.

7. On the Business Purpose tab, fill in the Usage, Location and select the Primary check box. For example:
   - Usage: Marketing
   - Location: 6op9
   - Primary: Yes

8. On the Contacts: Telephones sub-tab, enter a new contact and phone number.

9. Save your work.

### 2.3.8 Creating a Workflow With Notifications

Perform the following steps to create and run a workflow with notifications.

**Reference**

*Oracle Workflow Guide 2.5*, See Chapter 3, Defining a Workflow Process and Chapter 4, Defining Workflow Process Components

**Prerequisites**

None

**Responsibility**

Workflow Administrator

**Navigation**

Navigate to **Workflow >Launch Processes**.
Steps
1. In the Launch Processes window, In the Item Type column, click Document Management. If you have renamed the item types, this option appears in the Internal Name column as WFDM.

   The Initiate Workflow-WFDM page opens.

2. Enter values in the following fields:
   - Item Key: Enter your name plus a sequence number (for example, jdoe1001)
   - User Key: You may copy the value in the Item Key field
   - Process Name: Enter Document Review
   - Process Owner: Your logged in user name populates automatically
   - Send Document: Leave blank
   - Document Owner: Select a valid resource name
   - Document Reviewer: Choose one from the list of values
   - Comments: Enter Workflow Verification
   - Response Document: Leave blank

3. Click OK.

   The Activities List page opens to show workflow statuses. The status of the workflow you just initiated should be Active.

4. If the status of the workflow is Error, click Exception in the Result column to see an explanation of the error.

5. Click View Diagram to see a graphical representation of the workflow process.

   Leave the View Diagram window open as you continue to check the workflow.

6. Save your work.

To Review the Progress of a Workflow
Use the following procedure to verify that the Workflow notification is sent.

Steps
1. Login to your Personal Home Page.

2. In the list of Self Service Apps, choose the Workflow User Web Application responsibility.
3. In the Navigator, choose **Workflow >Find Notifications**.
   The Find Notifications page opens.

4. In the Type field, enter Document Management. In the To field, enter the document reviewer.

5. Click **Find**.
   The Worklist window opens.

6. Click **Subject** to open the notification.
   If you see the notification, then workflow is set up correctly.

7. Click **Approve** to return to the Worklist window.

**Further Verification**
You may go back to the View Diagram window that you opened earlier. Click **Reload** in the browser window to refresh the contents of the window. After the workflow process completes successfully, you can see a green line from the Start icon to the End (Approve) icon.

### 2.3.9 Defining Categories

You can use categories and category sets to group items for various reports and programs. Perform the following steps to define categories.

**Note:** Category sets may be used as a means to develop custom lists of items on which to report and sort. You can also create other category sets such as John’s Priority or Jane’s Priority, with categories like high, medium, and low.

**Reference**
*Oracle Inventory User’s Guide*, See Chapter 4, Item Setup and Control

**Prerequisites**
The categories you assign to a category set must have the same flexfield structure as the set itself. This is true even if you choose not to validate the category list.

**Responsibility**
Inventory
Navigation
Navigate to Setup > Items > Categories > Category Sets.

Steps
1. Select the appropriate organization name in the Organization window, if necessary.
2. In the Category Sets window, enter a unique category set name and description information.
3. Enter a flexfield structure.
4. Select a control level.
   - Master Level: Item assigned to this category set has the same category value in all organizations where it is assigned.
   - Org Level: Item assigned to this category set may have a different category value in each organization where it is assigned.
5. Select a default category.
   This is the default category used when assigning an item to the category set. For example, a category set may have a default category called New. After an item is assigned to New, you can override the default category and choose another relevant category for each item.
6. Decide whether or not an item can be assigned to multiple categories within this category set.
   - Enable: You can assign an item to multiple categories within a category set. For example, you may define a Hazard category set. In this case, an item may be assigned to both the Poison and Corrosive categories.
   - Not Enable: You can assign an item to exactly one category. For example, you may define a Web Display category set. In this case, an item can be assigned to only one default display category.
7. Decide whether or not to enforce the list of valid categories.
   - Enable: You can assign an item only to those categories defined as valid categories for this category set. For Oracle Purchasing, this check box is not applicable, and you can assign items only to categories defined as valid for this category set.
   - Not Enable: You can assign an item to any defined category that uses the same flexfield structure as this category set.
8. Select a list of valid categories.
   The list of values here includes only categories that use the same flexfield structure as the category set you are defining.
9. Save your work.

2.3.10 Defining Products and Platforms
You define and rate products and platforms in Oracle Inventory in order to set resource skill levels in the HTML Resource Manager. See the Oracle Inventory User’s Guide, See Chapter 5, Items for more information on how to define products and platforms.

Reference
Oracle Inventory User’s Guide, See Chapter 5, Items

2.3.11 Defining Unit of Measure Classes
Perform the following steps to define a unit of measure class.

Reference
Oracle Inventory User’s Guide, See Chapter 3 Units of Measure

Prerequisites
None

Responsibility
Inventory

Navigation
Navigate to Setup > Units of Measure > Classes.

Steps
1. In the Units of Measure Classes window, select File > New.
2. Enter a unique name for the unit of measure class.
3. Enter a description for the UOM class.
4. Define the base unit of measure for this class.
5. Enter a unique abbreviation for the unit of measure with a maximum length of three characters. Examples include, EA for each or HRS for hours.

6. Select the “inactive on” date from the date picker.

7. Save your work.

2.3.12 Defining Units of Measure

Units of measure are used by a variety of functions and transactions to express the quantity of items. The values defined in the Units of Measure window provide the list of values available in unit of measure fields in other windows. Units of measure are not organization-specific. Perform the following steps to define units of measure.

Reference

Oracle Inventory User’s Guide, See Chapter 3 Units of Measure

Prerequisites

At least one unit of measure class must exist.

Responsibility

Inventory

Navigation

Navigate to Setup > Units of Measure > Units of Measure.

Steps

1. With the Units of Measure window open, select File > New.

2. Enter a unique name for the unit of measure.

3. Enter a unique abbreviation for the unit of measure with a maximum length of three characters. Examples include, EA for each or HRS for hours.

4. Enter a Description for the UOM.

5. Select the check box if this is the base unit of measure for the unit of measure class.

6. Enter a unit of measure class.

7. Select an “inactive on” date from the date picker.
2. Save your work.

2.3.13 Creating a Supplier Contact

Set up suppliers in the Suppliers window to record information about individuals and organizations from whom you purchase goods and services. You can also enter employees whom you reimburse for expense reports. When you enter a supplier that does business from multiple locations, you store supplier information only once, and enter supplier sites for each location. You can designate supplier sites as pay sites, purchasing sites, RFQ only sites, or procurement card sites. For example, for a single supplier, you can buy from several different sites and send payments to several different sites. Most supplier information automatically defaults to all supplier sites to facilitate supplier site entry. However, you can override these defaults and have unique information for each site.

The system uses information you enter for suppliers and supplier sites to enter default values when you later enter transactions for a supplier site. Most information you enter in the Suppliers window is used only to enter defaults in the Supplier Sites window. When the system enters that information in a later transaction, it only uses supplier site information as a default, even if the supplier site value is null and the supplier has a value. If you update information at the supplier level, existing supplier sites are not updated.

When you enter a supplier, you can also record information for your own reference, such as names of contacts or the customer number your supplier has assigned to you. Perform the following steps to create a supplier contact.

Reference


Prerequisites

- Verify that the supplier does not exist in the system. Use the Suppliers Report and Supplier Audit Report.
- Define the following lookups in the Oracle Purchasing Lookups window: Pay Group, Supplier Type, Minority Group.
- Define Supplier Types in the Oracle Payables Lookups window.
- If you have installed Purchasing, complete Purchasing setup.
- If you use Oracle Purchasing, define Supplier Types in the Oracle Payables Lookups window.
If you use Oracle Purchasing, define FOB codes, Minority Groups, and Freight Terms codes in the Oracle Purchasing Lookups window.

If you use Oracle Purchasing, define Ship Via codes in the Defining Freight Carriers window.

**Responsibility**

Purchasing

**Navigation**

Navigate to **Supply Base > Suppliers**.

**Steps**

1. In the Suppliers window, enter a unique Supplier Name.

2. If the Supplier Number Entry option in the Financials Options window is set to Automatic, Payables automatically enters a Supplier Number for you. If this option is set to Manual, you must enter a unique Supplier Number.

3. (Optional) Enter the supplier’s tax identification number in the Taxpayer ID field; for example, an individual's social security number, or a corporation or partnership’s federal identification number/federal tax ID.

4. (Optional) Enter the value-added tax (VAT) registration number in the Tax Registration Number field if you are entering a VAT supplier.

5. Enter supplier information in the appropriate tabs of the Suppliers window.

6. In the Suppliers window, choose the Sites button to navigate to the Supplier Sites window. Enter at least one supplier site name and address.

7. Save your work.

### 2.3.14 Defining Sales Credit Types

Order Management uses sales credit types to determine if the sales credit for an order is a quota or non-quota amount. Perform the following steps to define sales credit types.

**Reference**

*Oracle Order Management User's Guide*, See Chapter 1, Setting up
Prerequisites
None

Responsibility
Order Management Super User

Navigation
Navigate to Setup > Sales > Credit Types.

Steps
1. Navigate to the Sales Credit Types window.
2. In the Sales Credit Type window, enter the Credit Type Name and Description for the credit type.
3. Select the Quota check box if the sales credit type applies to revenue quota sales credit that you assign to salespeople.
4. Select the Enabled check box to activate the sales credit type.
5. Save your work.

2.3.15 Setting Up Accounting Flexfields
Use descriptive flexfields to tailor General Ledger to fit your unique information needs. For example, you may want to collect additional information on budget organizations, such as the manager and the size of the organization. You can even define context–sensitive flexfields that prompt you for additional information based on your previous entries. Perform the following steps to set up accounting flexfields.

Reference
Oracle General Ledger User’s Guide, Chapter 9, Setup

Prerequisites
Use the Value Sets window to define any value sets you need.
Responsibility
General Ledger Super User

Navigation
Navigate to Setup > Financials > Flexfields > Descriptive > Segments.

Steps
Consult the following manuals for more information:
- Oracle General Ledger User Guide
- Oracle Applications Flexfields Guide

2.4 Oracle Collections Dependencies
The following sections list the required and conditional dependencies for this application.

2.4.1 Mandatory Dependencies
Oracle Collections requires the following related products and components to be installed and implemented:
- Oracle Accounts Receivable
- Oracle CRM Foundation Components including Interaction History, Resource Manager, Territory Manager, Task Manager, Notes, Fulfillment
- Oracle Universal Work Queue
- Oracle TeleSales
- Oracle iPayment is required to process credit card or bank EFT payments

2.4.2 Conditional Dependencies
The following applications are optional dependencies:
- Oracle Marketing Online
- Oracle Discoverer is required to generate lists used by Oracle Marketing Online
- Oracle Advanced Inbound
- Oracle Advanced Outbound
Complete installation and implementation steps as outlined in the following documents:

- Installing Oracle Applications
- Oracle System Administrator’s Guide

Create users and assign Oracle Sales Administration Responsibility and System Administrator responsibility to one or more users. All of the Oracle Collections implementation tasks can be completed using these responsibilities.
This section of the Oracle Collections Implementation Guide contains the following chapters:

- Chapter 3, "Implementation Overview"
- Chapter 4, "Implementation Tasks for Oracle Collections"
This overview of the implementation process for Oracle Collections includes the following topics:

- Section 3.1, "Process Description"
- Section 3.2, "Implementation Task Sequence"

3.1 Process Description

The steps needed for implementing Oracle Collections are listed in the order in which they should be carried out. When the step includes steps performed in another application such as Oracle CRM Application Foundation the relevant implementation guide is referenced.

3.2 Implementation Task Sequence

The following table describes the order and process of implementing Oracle Collections.
<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Type</th>
<th>Performed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implementing Oracle ERP Applications</td>
<td>In Oracle AR, set up banks, currencies, aging buckets, lockbox, payment methods, and credit memo workflow. See Section 4.1, &quot;Implementing Oracle ERP Applications&quot;</td>
<td>Forms</td>
<td></td>
</tr>
<tr>
<td>Setting Up Collections Aging Buckets</td>
<td>Set up aging buckets per the <em>Oracle Receivables User Guide</em>. See Section 4.2, &quot;Setting Up Collections Aging Buckets&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up Multiple Currencies</td>
<td>Set up multiple currencies following the instructions in <em>Oracle General Ledger User Guide</em>. See Section 4.3, &quot;Setting Up Multiple Currencies&quot;</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set Up Aging Bucket Filters</td>
<td>Relate a subset of your database with a set of aging buckets from Oracle Receivables. See Section 4.4, &quot;Set Up Aging Bucket Filters&quot;</td>
<td>HTML</td>
<td>Collections HTML Administrator</td>
</tr>
<tr>
<td>Creating Locations and Organizations</td>
<td>Set up organizations in Oracle HRMS. See Section 4.5, &quot;Creating Locations and Organizations&quot;</td>
<td>Forms</td>
<td></td>
</tr>
<tr>
<td>Creating Employees</td>
<td>Set up users as employees in Oracle HRMS. See Section 4.6, &quot;Creating Employees&quot;</td>
<td>Forms</td>
<td></td>
</tr>
<tr>
<td>Defining Resource Groups</td>
<td>Define a hierarchy of resource groups in CRM Resource Manager. Section 4.7, &quot;Defining Resource Groups&quot;</td>
<td>Forms</td>
<td>CRM Resource Manager</td>
</tr>
<tr>
<td>Setting Up Employees as Users</td>
<td>Set up user security and responsibilities. See Section 4.8, &quot;Setting Up Employees as Users&quot;</td>
<td>Forms</td>
<td>System Administrator</td>
</tr>
<tr>
<td>Importing Employees and Assigning Them Roles and Resource Groups</td>
<td>Use CRM Foundation Resource Manager to import employees from HRMS and assign them roles and resource groups. See Section 4.9, &quot;Importing Employees and Assigning Them Roles and Resource Groups&quot;</td>
<td>Forms</td>
<td>Collections Forms Administrator</td>
</tr>
<tr>
<td>Setting Up CRM Foundation Notes</td>
<td>You can use the predefined set of Collections note types and create note types of your own. See Section 4.10, &quot;Setting Up CRM Foundation Notes&quot;</td>
<td>Forms</td>
<td>CRM Administrator</td>
</tr>
<tr>
<td>Setting Up CRM Foundation Interaction History</td>
<td>Multiple steps as defined in the <em>Oracle CRM Application Foundation Implementation Guide</em>. See Section 4.11, &quot;Setting Up CRM Foundation Interaction History&quot;</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Implementation Task Sequence

#### Setting Up CRM
- **Foundation Tasks**: Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.12, "Setting Up CRM Foundation Tasks".
- **Foundation Calendar**: Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.13, "Setting Up CRM Foundation Calendar”.
- **Foundation Fulfillment**: Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.14, "Setting Up CRM Foundation Fulfillment”.
- **Foundation Territory Management**: Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. Collections uses Sales territories. See Section 4.15, "Setting Up CRM Foundation Territory Management”.

#### Oracle Universal Work Queue
- **Setting Up**: Steps as defined in the Oracle Universal Work Queue Implementation Guide. See Section 4.16, "Setting Up Oracle Universal Work Queue”.

#### Oracle iPayment
- **Setting Up**: Steps as defined in the Oracle iPayment Implementation Guide. See Section 4.17, "Setting Up Oracle iPayment”.

#### Collections Campaigns
- **Setting Up**: Collections campaigns are set up in Oracle Marketing Online. See Section 4.18, "Setting Up Collections Campaigns in Oracle Marketing Online”.

#### Scripting
- **Setting Up**: Set up scripts that agents can follow during phone calls. See Section 4.19, "Setting Up Scripting”.

#### Interaction Center
- **Enabling**: Interaction Center is part of Oracle Advanced Outbound and Oracle Advanced Inbound. See Section 4.20, "Enabling Interaction Center”.

#### Campaign Assignment And Wrap-up Administration
- **Setting Up**: Assign campaigns to agents and set up call wrapup per the Oracle TeleSales Implementation Guide. See Section 4.21, "Setting Up Campaign Assignment And Wrap-up Administration”.

#### Oracle iReceivables
- **Enable**: Optional. Follow the instructions in the Oracle iReceivables Implementation Guide to configure. See Section 4.22, "Enabling Oracle iReceivables”.

### Table 3–1 Collections Process

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Type</th>
<th>Performed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up CRM Foundation Tasks</td>
<td>Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.12, &quot;Setting Up CRM Foundation Tasks”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up CRM Foundation Calendar</td>
<td>Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.13, &quot;Setting Up CRM Foundation Calendar”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up CRM Foundation Fulfillment</td>
<td>Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. See Section 4.14, &quot;Setting Up CRM Foundation Fulfillment”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up CRM Foundation Territory</td>
<td>Multiple steps as defined in the Oracle CRM Application Foundation Implementation Guide. Collections uses Sales territories. See Section 4.15, &quot;Setting Up CRM Foundation Territory Management”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up Oracle Universal Work Queue</td>
<td>Steps as defined in the Oracle Universal Work Queue Implementation Guide. See Section 4.16, &quot;Setting Up Oracle Universal Work Queue”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Set up Oracle iPayment</td>
<td>Steps as defined in the Oracle iPayment Implementation Guide. See Section 4.17, &quot;Setting Up Oracle iPayment”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up Collections Campaigns</td>
<td>Collections campaigns are set up in Oracle Marketing Online. See Section 4.18, &quot;Setting Up Collections Campaigns in Oracle Marketing Online”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up Scripting</td>
<td>Set up scripts that agents can follow during phone calls. See Section 4.19, &quot;Setting Up Scripting”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enabling Interaction Center</td>
<td>Interaction Center is part of Oracle Advanced Outbound and Oracle Advanced Inbound. See Section 4.20, &quot;Enabling Interaction Center”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting Up Campaign Assignment And Wrap-up Administration</td>
<td>Assign campaigns to agents and set up call wrapup per the Oracle TeleSales Implementation Guide. See Section 4.21, &quot;Setting Up Campaign Assignment And Wrap-up Administration”</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Oracle iReceivables</td>
<td>Optional. Follow the instructions in the Oracle iReceivables Implementation Guide to configure. See Section 4.22, &quot;Enabling Oracle iReceivables”</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3–1 Collections Process

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Type</th>
<th>Performed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Scoring Component Types</td>
<td>Optional. The score component type consists of a PL*SQL statement that is used to quantify existing database information about a customer. See Section 4.23.1, &quot;Create Scoring Component Types&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML</td>
</tr>
<tr>
<td>Creating New Scoring Engines</td>
<td>Optional. Active scoring engines are run by Concurrent Programs to identify and categorize customers by set criteria. See Section 4.23.2, &quot;Create New Scoring Engines&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Adding Components to Scoring Engines</td>
<td>Optional. A scoring engine uses the PL*SQL statements contained in the components to categorize customers. See Section 4.23.3, &quot;Add Components to Scoring Engines&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Configuring Scoring Engine Components</td>
<td>Optional. Set ranges of values and assign a score to each. See Section 4.23.4, &quot;Configuring Scoring Engine Components&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Enter Parameters</td>
<td>Optional. You can enter parameters for a scoring component function. See Section 4.23.5, &quot;Entering Parameters for a Scoring Component Function&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Set Up Scoring Engine to Assign Delinquencies</td>
<td>Optional. A scoring engine can be used to assign delinquency statuses. See Section 4.23.6, &quot;Using a Scoring Engine to Assign Delinquency Status&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Setting up Scoring Filters (Universes)</td>
<td>Optional. Define subsets of your database for different scoring engines. See Section 4.23.7, &quot;Creating or Updating a Scoring Filter&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Create Work Item Templates</td>
<td>Optional. Create manual or automatic work items to use in strategies or checklists. See Section 4.24.1, &quot;Creating a Work Item Template&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Create Strategy Checklists</td>
<td>Optional. Create lists of work items to print in checklist form. See Section 4.24.2, &quot;Creating a Strategy Template&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Create Strategy Templates</td>
<td>Optional. Create a strategy of work items that is assigned automatically to specific delinquencies. See Section 4.24.2, &quot;Creating a Strategy Template&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
</tbody>
</table>
### Implementation Task Sequence

**Table 3–1 Collections Process**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
<th>Type</th>
<th>Performed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Work Items to Strategy Template</td>
<td>Optional. Add manual and automatic work items to a strategy template. See Section 4.24.3, &quot;Adding Work Items to a Strategy Template&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Create Strategy Filters</td>
<td>Optional. Define subsets of your database to apply to strategies. See Section 4.24.4, &quot;Creating or Updating a Strategy Filter&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML or Collections Manager HTML</td>
</tr>
<tr>
<td>Disabling Strategies</td>
<td>Optional. If you do not want to use the strategy functionality, you can disable it. See Section 4.25, &quot;Disabling Strategies&quot;</td>
<td>Forms</td>
<td></td>
</tr>
<tr>
<td>Setting Up Oracle Collections System Profiles</td>
<td>Set up profile options that relate to Collections. See Section 4.26, &quot;Setting Up Oracle Collections System Profiles&quot;</td>
<td>Forms</td>
<td>Collections Forms Administrator</td>
</tr>
<tr>
<td>Set Up Delinquency Prioritization Status</td>
<td>Set up filters and priorities that control the status displayed in the header for each customer. See Section 4.27, &quot;Set Up Delinquency Prioritization Status&quot;</td>
<td>HTML</td>
<td>Collections HTML Administrator</td>
</tr>
<tr>
<td>Enabling Web Directory Assistance</td>
<td>You set parameters that the application uses to build the URL to automatically send a query to your chosen directory assistance web site. See Section 4.28, &quot;Enabling Web Directory Assistance&quot;</td>
<td>HTML</td>
<td>Collections Administrator HTML</td>
</tr>
<tr>
<td>Running Concurrent Programs</td>
<td>Set up the frequency for running Collections concurrent programs. Section 4.29, &quot;Running Concurrent Programs&quot;</td>
<td>Forms</td>
<td>System Administrator</td>
</tr>
</tbody>
</table>
Perform the following tasks to implement Oracle Collections:

- Section 4.1, "Implementing Oracle ERP Applications"
- Section 4.2, "Setting Up Collections Aging Buckets"
- Section 4.3, "Setting Up Multiple Currencies"
- Section 4.4, "Set Up Aging Bucket Filters"
- Section 4.5, "Creating Locations and Organizations"
- Section 4.6, "Creating Employees"
- Section 4.7, "Defining Resource Groups"
- Section 4.8, "Setting Up Employees as Users"
- Section 4.9, "Importing Employees and Assigning Them Roles and Resource Groups"
- Section 4.10, "Setting Up CRM Foundation Notes"
- Section 4.11, "Setting Up CRM Foundation Interaction History"
- Section 4.12, "Setting Up CRM Foundation Tasks"
- Section 4.13, "Setting Up CRM Foundation Calendar"
- Section 4.14, "Setting Up CRM Foundation Fulfillment"
- Section 4.15, "Setting Up CRM Foundation Territory Management"
- Section 4.16, "Setting Up Oracle Universal Work Queue"
- Section 4.17, "Setting Up Oracle iPayment"
4.1 Implementing Oracle ERP Applications

Set up Oracle Receivables according to the steps outlined in Oracle Receivables User Guide. Oracle Collections requires the following items to be implemented:

- Banks
- Currencies
- Aging buckets
- Lockbox
- Payment methods
- Credit memo workflow

Do not allow negative numbers for invoices or debit memos.

4.1.1 Aging Buckets

Oracle Collections uses aging filters to relate a subset, or universe, of your customers in your database with a set of aging buckets from Oracle Receivables. For example,
you can age your new customers with aging buckets that start at 10 days, and age your older customers starting at 30 days. Or you can age a subsidiary company differently from the parent company. The filtered records can be used for scoring, determining delinquency (also done by scoring engines), and assigning strategies.

If you plan to utilize multiple aging buckets, then you must set up the buckets carefully. Keep the following points in mind:

1. Make sure the bucket ranges do not overlap.
2. Do not leave gaps between bucket ranges. For example, if your ranges are 10-20 days and 30-40 days, then there is a gap at 21-29 days that will not be included.
3. The maximum number of bucket lines per aging bucket is seven.
4. When you set up aging buckets, there is a sequence number for each range. Do not reuse sequence numbers, even from one set of aging buckets to another. The safest method is to start with 1, 2, 3, through 7 for the first aging bucket. When you create the next aging bucket, start with 8, and so on for each aging bucket.

Changes in aging buckets are not active until the Aging concurrent program is run. See Section 4.29, "Running Concurrent Programs" for more information.

4.1.2 Credit Card and EFT Payments

If you want to accept credit card or EFT payments in Oracle Collections through Oracle iPayment, then you need to set up these payment options correctly in Oracle Receivables.

1. Create a new remittance type for Collections Credit Card Payments and set it up as a cash remittance.
2. Create a new remittance type for Collections EFT Payments and set it up as a cash remittance.
3. Set the following system profile options to use the new remittance types:
   - IEX: Credit Card Payment Remittance
   - IEX: Electronic Funds Transfer Payment Remittance

4.2 Setting Up Collections Aging Buckets

Follow the instructions in Oracle Receivables User Guide to set up aging buckets. A profile option specifies the aging bucket used by Oracle Collections.
4.3 Setting Up Multiple Currencies

Set up multiple currencies following the instructions in Oracle General Ledger User Guide.

4.4 Set Up Aging Bucket Filters

Use aging filters to relate a subset of your database with a set of aging buckets from Oracle Receivables. For example, you can age your new customers with aging buckets that start at 10 days, and age your older customers starting at 30 days. Or you can age a subsidiary company differently from the parent company. The filtered records can be used for scoring, determining delinquency (also done by scoring engines), and assigning strategies. Use this procedure to create or update aging filters.

Prerequisites
Aging buckets are set up in Oracle Receivables
Table view was created by your database administrator

Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Collections> Aging. A list of existing aging filters appears.
2. If you want to create a new filter, then click Create. The Create Aging Filter page appears.
3. If you want to edit an existing filter, then click the filter name. The Aging Filter page appears.
4. Select the aging bucket to relate to the filtered records.
5. Change the filter name or enter a new filter name.
6. Select Y to enable the filter or N to disable it.
7. Use the LOV to select a view name.
8. Use the LOV to select a column to be used as the filter. You can select one of the following: payment_schedule_id, delinquency_id, or case_id.
9. Click Test.

The filter is tested and the number of records found appears in the Row Count.

10. If you are happy with your test results, then click Create to save the filter.

**Guidelines**

The data type of the column name must be number.

The view name must begin with IEX_F_. The view must be created in the APPS schema (the Database owner of the object must be = 'APPS'). The view must have three columns: payment_schedule_id, delinquency_id, and case_id (which are the same choices for the select_column field) and the view must be joined with iex_delinquencies.

### 4.5 Creating Locations and Organizations

Set up organizations in Oracle HRMS to record the physical locations where your employees work and all the different departments and sections which make up your enterprise. A default business organization has been set up for you, so this step is not required for sales and collections applications to be fully operational. However, you must set up organizations if you plan to use any financial ERP application in the future.

Organizations can also help you set up security for your sales and collections applications. For example, you can attach responsibilities with different levels of security to the different operating units you set up as organizations. Any individuals employed in those units automatically inherit that responsibility.

See the Organization Management chapter in *Using Oracle HRMS -- The Fundamentals* for detailed setup steps and *Multiple Organizations in Oracle Applications*.

### 4.6 Creating Employees

You must create the individuals who will be using the collections application you are implementing as employees before you can set them up as users.
Follow the steps found in *Managing People Using Oracle HRMS Release 11i*, Chapter 1 - Employee Management, Special Information Types, Entering and Maintaining a New Person. Make sure that you enter employee in the Category field.

The navigation paths for creating employees are different depending on whether you have a full license to Oracle HRMS or a shared license.

If you have the full installation of Oracle Human Resources, a module of Oracle HRMS, you must use HR and perform this step under the HRMS Manager responsibility.

### 4.6.1 With Full Oracle HRMS License
Responsibility: HRMS Manager
Navigation: People > Enter and Maintain

### 4.6.2 With Shared Oracle HRMS License
Responsibility: Collections Forms Administrator
Navigation: CRM Foundation > Resource Manager > Maintain Employees > Employees

**Note:** If you have the full installation of Oracle HRMS then you cannot create employees under the Collections Forms Administrator Responsibility using CRM Foundation > Resource Manager > Maintain Employees > Employees. You will receive an error message that you must use HRMS.

### 4.7 Defining Resource Groups
Use this procedure to set up resource groups. Resource groups:

- Determine how collections information is aggregated in reports.
- Are one of the factors that control the access by managers to collections information maintained by their subordinates.

If you want managers to access collections activities created by their subordinates, then you must set up a hierarchy of resource groups that mirrors your collections organization.
You can have multiple employees in one group. An employee in a group with the role of manager automatically becomes the manager of the other employees in that group and of the employees in the groups below in the hierarchy.

---

**Note:** You must not assign more than one employee with the role of Manager per group. Doing so will impact the reporting accuracy.

---

**Login**
Log in to Oracle Forms.

**Responsibility**
Collections Forms Administrator

**Prerequisites**
You must have CRM Resource Manager responsibility.
You must be defined as a resource.

**Steps**

1. Navigate to **Resource Manager > Maintain Resources > Groups**.
   
The Define Groups window appears.

2. To find an existing resource group:
   
   a. Click **Find** on the application toolbar to open the Find Group window.
   
   b. Select a group name from the list of values in the Group Name field and click **Find**. The application populates the Results section with the group name search results.
   
   c. Select a group name in the Results table and click **OK**. The application populates the Define Groups window with the group information.

3. To create a new group:
   
   a. Enter a group name in the Group Name field.
   
   b. Enter a brief description of the group in the Group Description field.
   
   c. Enter the effective dates for the group in the **Start** and **End** fields.
Defining Resource Groups

4. For each group in the hierarchy:
   a. Enter the group name.
   
   **Note:** If the window is not blank you can create a new record by clicking **New** on the toolbar.

   b. Enter an optional description.

   c. On the Parent Groups tab, enter the group, if any, that is above the current group in the group hierarchy.

   **Note:** You need not enter both parent and child groups. If you build your hierarchy by entering parent groups, then you need not enter child groups and vice versa. The missing groups are supplied by the application automatically.

   d. On the Child Groups tab, enter the groups that are below the current group in the group hierarchy.

   e. On the Usages tab, use the LOV to enter **Collections**. You must make this entry for the group to be recognized by Oracle Collections.

   f. Click **Save** on the toolbar.

**Guidelines**

- If a managers have their own delinquencies, then they should be part of their own groups.
- Use the Relations tab to relate Parent Groups
- Use the Sales & TeleSales Group and select Usage=Sales. Resource groups for collections are not available.
4.8 Setting Up Employees as Users

Use this procedure to set up individual employees as users for your application.

Login
Log in to Oracle Forms.

Responsibility
System Administrator

Prerequisites
None

Steps
   The Users window appears.
2. Enter a user name and password. You are asked to reenter the password a second time.
3. Use the Person List of Values (LOV) to select the employee that will be using the user name and password.
4. Assign one or more responsibilities to the user. The available responsibilities are:
   - Collections Agent
     This responsibility has access to eBusiness Center, Collections window, searches, processing payments, disputing invoices, and directory assistance.
   - Collections Agent HTML
     This responsibility has access to reports.
   - Collections Manager
This responsibility has access to all functions available to Collections Agent plus setting aging buckets, banks, lockbox, currency, Fulfillment templates, marketing campaigns, Interaction history, Discoverer workbooks, and territories.

- Collections Manager HTML
  This responsibility may function as the collections specialist who has access to the later-stage delinquency functionality, HTML collections screens, budgets, and actual costs for collecting and reports. The collections manager can also create and maintain strategies and collections work items, create and maintain scoring engines by adding scores to components, add aging filters, and set customer status priorities.

- Collections Forms Administrator
  This responsibility has access to system profiles, concurrent requests, setting up directory assistance, iPayment administration, Workflow, Advanced Outbound, tasks, territories and resources.

- Collections Administrator HTML
  This responsibility has access to reports, creating and maintaining strategies and collections work items, creating scoring component types, adding scores to components, adding components to scoring engines and weighting components, creating scoring engines, enabling or disabling scoring engines, adding aging filters, setting customer status priorities, and enabling web directory assistance.

5. Click Save in the toolbar.

**Guidelines**
Although the responsibilities have the same names as the roles you will assign in the next step, they perform a different function. Responsibilities are a general feature of all Oracle applications and control what features of the application a user can access. By contrast, the roles you set up in Resource manager control what collections information users can view and modify.

### 4.9 Importing Employees and Assigning Them Roles and Resource Groups

Use this procedure to import employees from Oracle HRMS.
Importing Employees and Assigning Them Roles and Resource Groups

Login
Log in to Oracle Forms.

Responsibility
Collections Forms Administrator

Prerequisites
You must set up the employees in HRMS first.

Steps
1. Navigate to CRM Foundation > Resource Manager > Maintain Resources > Import Resources.
   The Selection Criterion window appears.

2. Select Employee from the Resource Category drop-down list.

3. If you are importing a single employee, then use the List of Values in the Name field. For groups of employees, search by job title, competency, or other search criteria.

4. Click Search.
   The employees that match your search criteria appear.

5. Select the check boxes for the employees you want to import as resources into your application. The next step will assign a single role to each of the selected resources.

6. Click Create Resource.
   The Default Values window appears.

7. Use the Role LOV to select one of the available roles to assign to the resources. Assign a role with a role type of Collections. Available roles are Collections Agent and Collections Manager.

8. Click OK.
   The Selected Resources window appears. This window displays the list of employees about to be assigned the role.

9. If there are any employees on the list you do not want to receive this role, then deselect their Select check box.

10. Click Save Resource.
The Save Resource button grays out indicating that you have successfully imported the resources.

11. If you want to add additional roles to any of the employees then:
   a. Select the employee.
   b. Click Details.
      The Resource window displays information about the employee.
   c. On the Role tab, use the Role Type LOV to select Collections.
   d. Use the Role LOV to select the role.
   e. Change the start date to a date before today.
   f. Add any additional role for this employee by repeating the above three steps.
   g. Click Save on the toolbar and close the Resource window.

12. Assign resource groups to each employee and select the roles they are going to have in each. For each employee:
   a. Select the employee in the Selected Resource window.
   b. Click Details.
      The Resource window displays information about the employee.
   c. In the Group region of the Groups tab, use the Name LOV to assign a group to the employee.
   d. Use the Name LOV in the Group Member Role region to select one or more roles for this employee in the group.
   e. Change the start date to a date before today.
   f. Click Save on the toolbar.
   g. Repeat the above three steps for each group to which you want to assign the employee.

Guidelines
- Role type must be Collections or user will not be able to log into Oracle Collections. Collections managers need to have Collections roles. Seeded roles include Collections Agent and Collections Manager. You can create additional collections roles, but Oracle recommends you use the seeded roles as these are tied to Oracle Collections functionality.
You can assign a resource to multiple groups, but a group can have only one manager.

Managers should be assigned to their own group if they manage their own delinquencies.

If you are moving agents from one group to another, do not remove them from their original group. Instead, click **Move** and add them to the new group. This will automatically end date their previous group membership.

**See Also**

### 4.10 Setting Up CRM Foundation Notes

Oracle Notes is a CRM Foundation component which comes with a set of predefined Collections note types. You can choose whether or not you want to use the predefined set of note types and create customized note types of your own.

Refer to the Implementing Notes section of the *Oracle CRM Application Foundation Implementation Guide* for additional information about setting up Oracle Notes.

Use the following procedure to set up note types.

**Login**

Log in to Oracle Forms.

**Responsibility**

CRM Administrator

**Prerequisites**

None

**Steps**

1. Navigate to **Notes Setup > Note Type Setup**.
   
   The Application Object Library: Note Types Lookups window appears.

2. Define the code, meaning, and description as desired. You are only required to define a tag for a new, customized note type.

3. **Save** the record when you are finished.
Deleting an Existing Note Type
Assign an end date to an existing note type to delete it.

Mapping Note Types to a Source
When you map a note type to a source object, you limit the visible note types for that source to the defined subset of note types.

Note Types
Collections uses the following note types:
- IEX_DUNNING Collections Dunning
- IEX_PAYMENT Collection Payment
- IEX_PROMISE Collections Promise to Pay
- IEX_DISPUTE Collections Dispute
- IEX_INVOICES Collections Invoices
- IEX_REVERSAL Collections Payment Reversal
- IEX_DELINQUENCY Collections Delinquency
- IEX_CASE Collections Case

Notes can be associated with any object, such as a payment, an organization, a dispute, or a promise to pay.

4.11 Setting Up CRM Foundation Interaction History
Refer to the Implementing Interaction History section of the Oracle CRM Application Foundation Implementation Guide for information about setting up Interaction History.

Collections records the following interaction actions for Interaction History:

<table>
<thead>
<tr>
<th>Action</th>
<th>Action Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment</td>
<td>Reversal</td>
</tr>
<tr>
<td>Payment</td>
<td>Credit Card</td>
</tr>
<tr>
<td>Payment</td>
<td>Bank Transfer</td>
</tr>
<tr>
<td>Payment</td>
<td>Promise to Pay</td>
</tr>
</tbody>
</table>
4.12 Setting Up CRM Foundation Tasks

Refer to the Implementing Task Manager section of the *Oracle CRM Application Foundation Implementation Guide*. Oracle Collections functionality is limited to the following:

1. Defining Task Status (Status Transition and Rules is not supported)
2. Defining Task Priorities
3. Defining Task Types (Resource Requirements and Workflow are not supported)
4. Defining Task Templates (Dependencies and recurrences are not supported).

<table>
<thead>
<tr>
<th>Action</th>
<th>Action Item</th>
</tr>
</thead>
<tbody>
<tr>
<td>Payment</td>
<td>Terms</td>
</tr>
<tr>
<td>Dispute</td>
<td>Invoice</td>
</tr>
<tr>
<td>Dispute</td>
<td>Debit Memo</td>
</tr>
<tr>
<td>Dispute</td>
<td>Send Copy of Invoice</td>
</tr>
<tr>
<td>Directory Assistance</td>
<td>Dial New Number</td>
</tr>
<tr>
<td>Case</td>
<td>Create Case</td>
</tr>
<tr>
<td>Strategy</td>
<td>Create Strategy</td>
</tr>
<tr>
<td>Strategy</td>
<td>Modify Strategy</td>
</tr>
</tbody>
</table>

4.13 Setting Up CRM Foundation Calendar

Refer to the Implementing Calendar section of the *Oracle CRM Application Foundation Implementation Guide* for information about setting up calendar functionality.

4.14 Setting Up CRM Foundation Fulfillment

You must implement fulfillment if you plan to deliver collections-related documents or collateral to customers. Refer to the Fulfillment section of the *Oracle CRM Application Foundation Implementation Guide* for information about setting up e-mail, fax, and print servers as well as the electronic master documents themselves.
4.15 Setting Up CRM Foundation Territory Management

4.15.1 Setting Up Territories

Navigation
CRM Foundation > Territory Manager > Territory Administration

Territory Manager provides user interfaces and functionality that organizations can use to manage sales territories. If you choose not to set up Territory Manager, then all agents will have access to all customer delinquencies.

Use Territory Manager to automatically assign sales and collections teams based on their availability and expertise. Also use it to make sales information more secure by restricting personnel access to customer data.

Most sales territories are one-dimensional. They can assign tasks to employees based on geography or company size. Territory Manager makes it possible for you to create multidimensional territories using any number of such criteria. These criteria include:

- Postal code
- Area code
- Country
- Vertical market
- Company size
- Product expertise

For example, you can assign all large customers within a specific geographical area only to those sales representatives who have an expert knowledge on how to collect from that type of customer.

You can create multiple such territories for individuals or for teams of sales and collections representatives. Think of Territory Manager as a high-level programming tool that determines the assignment of tasks and resources within your company. Refer to the Implementing Territory Manager section of the Oracle CRM Applications Foundation Implementation Guide for information about setting up territory management.
Guidelines for Sales/Collections Applications

- You must create your territories under the Oracle Sales and TeleSales folder in the Navigator.
- You must choose the transaction type of Account on the Overview tab.

By selecting Account you can:
- Use any of the available account qualifiers to set up your territories.
- Assign the different resources in the territory to access account information. You can assign a single resource to one or more of these Access Types on the Resources tab. Different resources can be set up to gain access to different types of information.

Available Transaction Qualifiers

Oracle sales applications support the following transaction qualifiers for creating territories:

The following account qualifiers are available:
- Account Classification
- Account Code
- Account Hierarchy
- Area Code
- City
- Company Annual Revenue
- Country
- County
- Customer Category
- Customer Name Range
- Customer Name Range Group
- Number of Employees
- Postal Code
- Province
- Sales Partner of
4.15.2 Running Concurrent Programs for Territory Assignment

**Forms Navigation**
Concurrent Requests > Run

After you have completed the territory setups you must run the following concurrent programs in the order they are listed here:

1. Generate Territory Package: This concurrent program, available by logging in under the CRM Administration responsibility, builds the API that returns the winning territories which are defined in territory setup. It must be run at least once before you import leads and each time after you modify the territory setup. You need not run this program every time you import leads.

2. Assign Territory Access: This concurrent program assigns new territory access to sales force employees. The program prepares database tables for parallel processing. It requires setting two profile options:
   - OS: Territory Minimum Number of Records for Parallel Processing
   - OS: Territory Number of Child Processes

Refer to the Implementing Territory Manager section of the *Oracle CRM Application Foundation Implementation Guide* for information about setting up territory management.

**Guidelines**

No separate Collections territories are available. Set up and use sales territories. Use the Sales & TeleSales Group and select Usage=Sales.

4.16 Setting Up Oracle Universal Work Queue

Refer to the *Oracle Universal Work Queue Implementation Guide* for information about setting up the Universal Work Queue and creating new nodes.

Collections has three UWQ nodes to manage delinquencies, strategy work items, and broken promises.

There are several UWQ profile options that determine the order of the collections nodes as well as if they are presented. UWQ profile options begin with IEU. The
profile option IEU: Non-Media: Navigate determines whether a new application window is opened every time the user selects a new work item. Set to Yes to tell UWQ to reuse the same application window when a user selects a new work item. Set to No if you want UWQ to open a new additional window when users select a new work item. Set to Yes to save computer resources. The profile option can be set at the site, application, responsibility, and user levels.

4.17 Setting Up Oracle iPayment

Refer to the Oracle iPayment Implementation Guide for detailed steps related to implementing and configuring this module.

4.18 Setting Up Collections Campaigns in Oracle Marketing Online

Refer to Oracle Marketing Online Implementation Guide and Oracle Marketing Online User Guide for information on how to set up marketing campaigns.

4.19 Setting Up Scripting

Follow the instructions in the Oracle Scripting Implementation Guide and Oracle Scripting User Guide to set up scripts for your agents.

4.20 Enabling Interaction Center

Follow the instructions in Oracle Advanced Outbound Implementation Guide and Oracle Advanced Inbound Implementation Guide.

If advanced outbound is installed, then set OTS: Advanced Outbound Installation to Yes.

4.21 Setting Up Campaign Assignment And Wrap-up Administration

See the instructions in the Oracle TeleSales Implementation Guide to set up the following:

- Assign campaigns to agents (If you are using Oracle Advanced Outbound, then Advanced Outbound campaigns can be assigned to Agents but not to Groups.)
- Create outcomes, results, and reasons for call wrapup
- Link outcomes to results and reasons
Enabling Oracle iReceivables

- Assign outcomes to campaigns

4.22 Enabling Oracle iReceivables

Although there is no direct integration between Oracle Collections and Oracle iReceivables, use of the iReceivables product allows your customers to go online and review, pay, or dispute their bills. This reduces the need for internal collectors to work with customers. Follow the instructions in the Oracle iReceivables Implementation Guide to configure.

4.23 Set Up Scoring

Perform the following optional tasks to set up your own scoring engines.

- Section 4.23.1, "Create Scoring Component Types"
- Section 4.23.2, "Create New Scoring Engines"
- Section 4.23.3, "Add Components to Scoring Engines"
- Section 4.23.4, "Configuring Scoring Engine Components"
- Section 4.23.5, "Entering Parameters for a Scoring Component Function"
- Section 4.23.6, "Using a Scoring Engine to Assign Delinquency Status"
- Section 4.23.7, "Creating or Updating a Scoring Filter"

4.23.1 Create Scoring Component Types

The score component type consists of a PL/SQL statement that is used to quantify existing database information about a customer. A scoring component type is a PL/SQL function or a select statement that returns one integer value. Use this procedure to create a scoring component type.

Login

Use your HTML login jtflogin.jsp page to log in to Self Service Administration.

Responsibility

Collections Administrator HTML

Prerequisites

You must know how to write PL/SQL statements and functions.
Set Up Scoring

Steps
1. Navigate to Administration > Collections > Score Components.
   A list of existing score component types appears.
2. Click Create Type.
   The Create Component Type page appears.
3. Enter a descriptive name for the component type.
4. In the Score Component Value field, enter a PL/SQL expression.
5. Flag the component type as active or inactive.
6. Click Create to save the new component type.

The new component type is ready to be added to a scoring engine.

4.23.2 Create New Scoring Engines

Five scoring engines are supplied with Oracle Collections. These cannot be removed although others can be added. Active scoring engines are run by Concurrent Programs to identify and categorize customers by set criteria. Use this procedure to create a new scoring engine.

Login
Use your HTML login jtflogin.jsp page to log in to Self Service Administration.

Responsibility
Collections Administrator HTML or Collections Manager HTML

Prerequisites
None

Steps
1. Navigate to Administration > Collections > Scoring Engine.
   A list of scoring engines appears. Several scoring engines are supplied with Oracle Collections which cannot be removed. You can add others.
2. Click Create Scoring Engine.
   The Create Scoring Engine page appears.
3. Enter a name for the engine.
4. Optionally, enter a description.
5. Flag the scoring engine as enabled or disabled.
6. Enter beginning and end dates for the scoring engine to be active.
7. Click Create to save the new scoring engine.

The scoring engine is ready to be given components.

**Guidelines**

The following seeded scoring engines are shipped with Oracle Collections:

1. Oracle Collections Delinquent Party Score Engine
2. Invoice Delinquency Management Engine
3. Case Delinquency Management Engine
4. Oracle Collections Delinquent Case Scoring Engine
5. Oracle Collections Delinquent Invoice Scoring Engine

Note that Engine #2 creates delinquencies from Receivables Invoices and Engine #5 works in conjunction to perform additional processing. Also, note that Engine #3 creates delinquencies from Lease Management contracts and Engine #4 performs additional processing. Refer to the *Oracle Collections User Guide* for detailed instructions on how to re-use the Case Scoring Engines and re-define the parameters used to determine delinquency and pre-delinquency.

If you are implementing Oracle Lease Management, then there is a seeded scoring engine used for scoring cases. The parameters for that scoring engine cannot be changed. You can, however, copy that scoring engine and change the parameters for it.

### 4.23.3 Add Components to Scoring Engines

A scoring engine uses the PL*SQL statements contained in the components to categorize customers. Use this procedure to add components to scoring engines.

**Login**

Use your HTML login jtflogin.jsp page to log in to Self Service Administration.
Responsibility
Collections Administrator HTML or Collections Manager HTML

Prerequisites
A scoring engine must exist.
Component types must exist.

Steps
1. Navigate to Administration > Collections > Scoring Engine.
   A list of scoring engines appears. Several scoring engines are supplied with
   Oracle Collections which cannot be removed. You can add others.
2. Click a Score ID link.
   The details for the selected scoring engine appear.
3. Click Add Component.
   A new component row appears.
4. Use the LOV to choose a component type. You can search in the LOV by
   component name.
5. Add weight to the components. All component weights for a scoring engine
   must add up to 1.0.
6. Set the enabled flag for the component.
7. Click Update to save the component.
The components are ready to be scored.

Guidelines
The following three scoring values are shipped with Oracle Collections:
- Total number of delinquencies in the past 12 months
- Total amount owed (sum of all open delinquencies)
- Total number of years the customer has been doing business with the collecting organization
4.23.4 Configuring Scoring Engine Components

Each component of a scoring engine uses a PL*SQL statement to convert customer database information to a value, for example, total number of outstanding invoices. Use this procedure to set ranges of values and assign a score to each. To continue with the example, a user assigns a value range of -99999 to 0 a score of 0, a range of 1-5 a score of 25, a range of 6-20 a score of 50, and a range of 21 to 99999 a score of 75.

Login
Use your HTML login jtflogin.jsp page to log in to Self Service Administration.

Responsibility
Collections Administrator HTML or Collections Manager HTML

Prerequisites
A scoring engine must exist and must have components assigned to it.

Steps
1. Navigate to Administration > Collections > Scoring Engine.
   A list of scoring engines appears. Several scoring engines are supplied with Oracle Collections which cannot be removed. You can add others.
2. Click a Score ID link.
   The details for the selected scoring engine appear.
3. Click the link for the score component ID.
   The Score Component Details page appears.
4. Starting with the lowest range of values, enter your lowest and highest value for the first range. The range of values compares with the calculated values from the PL*SQL statement in the component type. The range must be contiguous and non-overlapping. Ranges must be from -99999 to 99999.
5. Enter an arbitrary value you want assigned to every customer that scores within the value range in step 4.
6. Click Update to save your scores.

Your scoring engine is available to perform calculations when run with the Create Delinquencies and Score Customers concurrent program set.
Refer to the Oracle Collections User Guide for detailed instructions on how to re-use the case scoring engines and re-define the parameters used to determine delinquency and pre-delinquency. Remember that the concept of a case is specific to collections for Oracle Lease Management.

### 4.23.5 Entering Parameters for a Scoring Component Function

A score component type can be a function. It is possible to create the function using variables. The Create Score Component Parameters page can then be used to enter or change the values relating to the variables which are called codes in the page. The information is stored in a name, value pairs table. Use this procedure to enter parameters for a scoring component function.

**Prerequisites**

A scoring engine must exist and must have a score component type that uses a function containing variables.

**Login**

Log in to Oracle HTML Applications

**Responsibility**

Collections HTML Administrator

**Steps**

1. Navigate to Administration > Collections > Scoring > Scoring Engine.
   
   A list of scoring engines appears. Several scoring engines are supplied with Oracle Collections which cannot be removed. You can add others.

2. Click a Score ID link.
   
   The details for the selected scoring engine appear.

3. Click Parameters.
   
   The Score Component Parameters page lists current parameters.

4. If you want to delete a parameter, then select Remove and click Update.

5. If you want to update the parameters for a score component, then click the component value detail link.
   
   The Score Component Parameter page appears.
6. If you want to create a new parameter, then click Create.
   The Create Score Component Parameter page appears.
7. In the Code field enter the variable as it appears in your function code. (Be sure to type the value correctly.)
8. Enter a value for the variable.
9. Optionally, enter a description.
10. Select Yes to make the parameter active.
11. Click Update to save your change or click Create to save a new parameter.

**Guidelines**
If you are implementing Oracle Lease Management, then there is a seeded scoring engine used for scoring cases. The parameters for that scoring engine cannot be changed. You can, however, copy that scoring engine and change the parameters for it.

### 4.23.6 Using a Scoring Engine to Assign Delinquency Status
For the most part, this scoring engine is used to assign delinquency statuses to selected objects (Oracle Receivables transactions or Oracle Lease Management cases). The available statuses are Delinquent, Pre-Delinquent, and Current. Use this procedure to set the scoring ranges for each delinquency status. The score that is compared to the ranges is the total score for the scoring engine.

**Prerequisites**
A scoring engine must exist and must have a score component type.

**Login**
Log in to Oracle HTML Applications

**Responsibility**
Collections HTML Administrator

**Steps**
1. Navigate to Administration > Collections > Scoring > Scoring Engine.

   A list of scoring engines appears. Several scoring engines are supplied with Oracle Collections which cannot be removed. You can add others.
2. Click a Score ID link.
   The details for the selected scoring engine appear.

3. Click Delinquency Status.
   The Scoring Range Configuration page appears.

4. Enter the ranges, starting with the lowest score of 1. The highest score is 100.
   Make sure that the ranges do not overlap and that there are no values missing
   between ranges.

5. Select a status for each range. Options are Current, Pre-delinquent, and
   Delinquent.

6. Click Update.

4.23.7 Creating or Updating a Scoring Filter
You can limit the scope of a scoring engine by using a filter to apply it to a specified
view and column. This results in the scoring engine being used for a group of
customers in the database. Use this procedure to create or update a filter for an
existing scoring engine.

Prerequisites
Scoring engine exists
Table view was created by your database administrator

Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Collections > Scoring > Scoring Engine.
   A list of scoring engines appears. Several scoring engines are supplied with
   Oracle Collections which cannot be removed. You can add others.

2. If the scoring engine does not have a filter, in the Filter column click Create.
   The Scoring Filter page appears.
3. If you want to edit an existing filter, then click the filter name. The Scoring Filter page appears.
4. Change the filter name or enter a new filter name.
5. Select Y to enable the filter or N to disable it.
6. Use the LOV to select a view name.
7. Use the LOV to select a column to be used as the filter.
8. Click Test. The scoring engine is tested with your new filter and the number of records found appears in the Row Count.
9. If you are happy with your test results, then click Create to save the filter.

Guidelines
The data type of the column name must be number.
The view name must begin with \textit{IEX\_F\_}. The view must be created in the APPS schema (the Database owner of the object must be = 'APPS').

4.24 Set Up Strategies
Perform the following optional steps to set up your own strategies.

- Section 4.24.1, "Creating a Work Item Template"
- Section 4.24.2, "Creating a Strategy Template"
- Section 4.24.3, "Adding Work Items to a Strategy Template"
- Section 4.24.4, "Creating or Updating a Strategy Filter"

4.24.1 Creating a Work Item Template
A strategy is made up of one or more manual or automated work items. A work item is a step needing execution. A manual work item is displayed as an entry on the Universal Work Queue Work Item queue for the assigned collector that can be sorted by priority and other methods. Upon execution of a work item it is removed from the queue. Use this procedure to create a work item template or a checklist.

Prerequisites
None
Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Strategy > Work Item Template.
   The Work Item Template Summary page appears.
2. Click Create.
   The Create Work Item Template page appears.
3. Enter a work item name and description.
4. Choose either manual or automatic for the work type. Manual work items are assigned to resources based on a combination of skills and territories. Automatic work items are executed by the system running a workflow associated to the work item template.
5. Choose a category type, such as e-mail.
6. If the work item is manual, then you can optionally choose a skill required for the step.
7. If you want to use a custom work flow that you created for this work item, then select it from the LOV. Leave the field blank to use the standard work flow.
8. Optionally, enter pre- and post-execution wait times.
9. In the Option field, choose Yes if you want to have the work item automatically closed after the expiration of the option wait time.
10. Optionally, enter option wait time information.
11. Optionally, enter the closure time limit for the work item to be completed.
12. If you want a notification sent to the manager when the closure time limit is reached, then select Yes in the Escalation field.
13. If you want notification to be sent to the next manager if the manager does not acknowledge the notification, then enter a schedule wait time after which the notification is sent.
14. Set Same Resource to Yes if you want the same resource assigned to the previous work item assigned to this work item during territory assignment.

15. If you want an e-mail workflow notification of the work item sent to the user assigned to the item, then select Yes in the Notify field.

16. If the work item requires automatically sending something to the customer using Oracle Fulfillment, then select a Fulfillment template.

17. Click Create to save the template.

4.24.2 Creating a Strategy Template

A strategy is created initially by the collections manager as an inactive, unassigned template to be used in the future. It is created once and then assigned to specific delinquencies in the future. When a strategy is assigned to a delinquency a copy of it is created and becomes active. Use this procedure to create a strategy template.

Prerequisites
None

Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Strategy.
   The Strategies Summary page appears.
2. Click Create.
   The Create Strategy page appears.
3. Enter a name for the strategy.
4. Enter a number for the rank the strategy applies to.
5. If you want to enable the strategy, then select Y.
6. Select the category type that the strategy applies to.
7. If you want this to be a checklist and not a strategy, then select Y. If this is a strategy, then select N.

8. If you want to associate a 1-to1 Fulfillment template as a checklist, then select the checklist template.

9. If you want to allow collectors to change this strategy, then select Y for Change Strategy.

10. Enter a range of dates when the strategy is valid.

11. Click Create to save your strategy template.

4.24.3 Adding Work Items to a Strategy Template

A strategy template can include one or more manual or automated work items. Use this procedure to add work items to a strategy template.

Prerequisites
None

Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Strategy.
   The Strategies Summary page appears.

2. Select an existing template.
   The Update Strategy Template page appears.

3. Click Work Item Detail.
   The Work Item Detail page lists the work items assigned to the strategy template.

4. Click Add.
   The Add Work Item Template page lists available work item templates.
5. Select one or more templates to add.
6. Click Select.
   The list of strategy work items includes the work item you just added.
7. Enter a number in the Order field to establish the sequence of the added work item in relation to the existing work items.
8. Click Update.

4.24.4 Creating or Updating a Strategy Filter
Use a filter to limit your strategy to a subset of your database, such as all customers in a specified country. Use this procedure to update an existing filter or create a new filter.

Prerequisites
Table view was created by your database administrator

Login
Log in to Oracle HTML Applications

Responsibility
Collections HTML Administrator

Steps
1. Navigate to Administration > Strategy.
   The Strategies Summary page appears.
2. Click the link in the Filter column for your strategy.
   The Strategy Filter page appears.
3. Change the filter name or enter a new filter name.
4. Select Y to enable the filter or N to disable it.
5. Use the LOV to select a table view name.
6. Click Test.
   The filter is tested and the number of records found appears in the Row Count.
7. If you are happy with your test results, then click **Create** or **Update** to save the filter.

**Guidelines**

The filter name must begin with `IEX_F_`. The view must be created in the APPS schema (the Database owner of the object must be = 'APPS').

The Delinquency ID must be a column in the view.

### 4.25 Disabling Strategies

The strategy module automates the collections process by the creation of collections strategies and strategy work items. Collections managers create strategy templates which are pre-defined sets of steps for the recovery of delinquent objects such as invoices from Oracle Receivables or cases as identified by Oracle Lease Management. Strategy templates are reusable. They leverage the Oracle Collections Scoring Engine which identifies delinquent, pre-delinquent, and current objects and then has the appropriate strategy assigned.

You can disable the strategy functionality by performing the following steps:

**Login**

Log in to Oracle Forms

**Steps**

1. Navigate to Profile > System > Set and set the system profile option `IEX: Strategy Disabled` to No.

2. Navigate to Security > Responsibility and add the function `Coll Strategy Tab` to the menu exclusion list for the responsibility `Collections Agent` or any responsibility for which the Collections Center is launched.

3. Navigate to Applications > Menu and open the menu item `IEX_ADMIN_HTML_FOR_MGR`. Remove the prompt for Submenu > `IEX: Strategy Admin Setup`.

4. Open the menu item `IEX_ADMIN_SETUP_MGR` and remove the prompt for submenu > `IEX: Strategy Main Submenu`. 
4.26 Setting Up Oracle Collections System Profiles

Oracle applications let you set up your applications according to your company’s business requirements. System profiles define how an application behaves for users.

The procedure for setting up and changing profile options is the same for all Oracle applications. For a detailed description of the procedures, refer to the Oracle Applications System Administrator’s Guide.

Login
Log in to Oracle Forms.

Responsibility
Collections Forms Administrator

Prerequisites
None

Steps
1. Choose Oracle Sales Setup > Profiles.
   The Find System Profile Values window appears.
2. Enter your search criteria in the Display region.
3. Click in the Profile Field. Enter a partial name of the profile using "%" as a wildcard.
4. Click Find.
   The found profiles are displayed in the System Profile Values window.
5. Click in the field of the profile you want to set or change.
6. Select a value from the List of Values (LOV).
7. Click Save on the toolbar.

The following table lists the Oracle Collections profile names, descriptions, and applicable default values.
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEU: Non-Media: Navigate</td>
<td>Universal Work Queue</td>
<td>Set to Yes to tell UWQ to reuse the same application window when you select a new work item. Set to No if you want UWQ to open a new additional window when you select a new work item. Set to Yes to save your computer resources. Can be set at the site, application, responsibility, and user levels.</td>
<td>No</td>
</tr>
<tr>
<td>IEU: Queue: Delinquencies</td>
<td>Universal Work Queue</td>
<td>Choose yes to include delinquencies in Universal Work Queue.</td>
<td></td>
</tr>
<tr>
<td>IEU: Queue Order: Delinquencies</td>
<td>Universal Work Queue</td>
<td>Enter number 1, 2, or 3 to specify the order in which delinquencies appears in Universal Work Queue.</td>
<td></td>
</tr>
<tr>
<td>IEU: Queue: Promises</td>
<td>Universal Work Queue</td>
<td>Choose yes to include promises to pay in Universal Work Queue.</td>
<td></td>
</tr>
<tr>
<td>IEU: Queue Order: Promises</td>
<td>Universal Work Queue</td>
<td>Enter number 1, 2, or 3 to specify the order in which delinquencies appears in Universal Work Queue.</td>
<td></td>
</tr>
<tr>
<td>IEX: Activity Enabled in Dispute</td>
<td>Interactions</td>
<td>If set to Yes, an interaction is started when a dispute is created. If set to No, then disputes are not tracked.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Activity Enabled in Payment</td>
<td>Interactions</td>
<td>If set to Yes, an interaction is started when a payment is made. If set to No, then payments are not tracked.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Activity Enabled in Promises</td>
<td>Interactions</td>
<td>If set to Yes, an interaction is started when a promise to pay is created. If set to No, then promises are not tracked.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Approval Required for Promise</td>
<td>Promise</td>
<td>Set to yes if an approval is required for promises. If so a workflow is launched to obtain the approval.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Auto Fulfill</td>
<td>Fulfillment, Transactions</td>
<td>Set to Yes to call Oracle Foundation Fulfillment upon completion of a transaction. Fulfillment automatically sends a confirming document to the customer upon transaction completion. If set to No, agent can use Collateral to send documents to the customer.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Automatically Populate Grids</td>
<td>Collections</td>
<td>Set to Yes to automatically populate grids upon querying. Set to No to require the Populate button to be clicked to process the query. Use No if you have large amounts of data. This profile is set at the user level.</td>
<td></td>
</tr>
<tr>
<td>IEX: Automatically Start Interactions</td>
<td>Interaction</td>
<td>Set to Yes to automatically start interaction tracking if an action is started.</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEX: Automatically Get UWQ Work Queue</td>
<td>Universal Work Queue</td>
<td>Set to yes to have dunning, broken promises, and delinquencies automatically feed work to the user upon completion of work item. Set to No to require the user to return to UWQ to obtain the next work item.</td>
<td></td>
</tr>
<tr>
<td>IEX: CB Customer Notification Email From</td>
<td>Lease Management</td>
<td>The FROM EMAIL ID of the email sent to the customer, by concurrent notification API, to notify about intent to report to the credit bureau.</td>
<td></td>
</tr>
<tr>
<td>IEX: CB Customer Notification Email Subject</td>
<td>Lease Management</td>
<td>Subject of the email sent to the customer, by concurrent notification API, to notify about intent to report to the credit bureau.</td>
<td></td>
</tr>
<tr>
<td>IEX: CB Customer Notification Email Template</td>
<td>Lease Management</td>
<td>Content id of the notification template, which is used to inform the customer of the intent to report the customer to the credit bureau. It has to be populated with the content id of the template after the template has been created in fulfillment. This is used by the concurrent notification API to generate an email, which is sent to the customer to notify about intent to report to the credit bureau.</td>
<td></td>
</tr>
<tr>
<td>IEX: CB Notification Grace Days Lease Management</td>
<td>Lease Management</td>
<td>After the customer has been notified about intent to report to the credit bureau, this user profile specifies the number of days before a followup is initiated in order to make a decision to report the customer to the credit bureau.</td>
<td></td>
</tr>
<tr>
<td>IEX: Collections Bucket</td>
<td>Collections</td>
<td>The name of the aging bucket created in AR that you want to use for Collections.</td>
<td></td>
</tr>
<tr>
<td>IEX: Collections Rate Type</td>
<td>Collections</td>
<td>You create currency conversion rate types in Oracle GL. Choose the one to use for Collections.</td>
<td></td>
</tr>
<tr>
<td>IEX: Credit Card Payment Remittance</td>
<td>Payment</td>
<td>Specify the payment method set in AR that corresponds to this remittance type.</td>
<td></td>
</tr>
<tr>
<td>IEX: Credit Hold of Delinquencies</td>
<td>Delinquency and Lease Management</td>
<td>Set to Yes if you are using Lease Management. Set to No if you are not. No disables the credit hold request check box on the Delinquency tab.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Default Bankruptcy Notice of Assignment</td>
<td>Lease Management</td>
<td>When the Flag is set on the Bankruptcy screen, this profile is used. If the profile is set to yes IEX makes a call to OKL to determine if the Notice of Bankruptcy should be sent. If set to no, then IEX does not make a call.</td>
<td></td>
</tr>
<tr>
<td>IEX: Default Date Range Span</td>
<td>Histories, Transactions, Notes</td>
<td>Enter the number of days from the current date for the earliest date to be included in a search or in displayed information.</td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEX: Default Exchange Rate Type</td>
<td>Collections</td>
<td>Enter the exchange rate type from AR to be used for Collections</td>
<td></td>
</tr>
<tr>
<td>IEX: Default Payment Method</td>
<td>Payment</td>
<td>Choose the type of payment tab to appear when the user opens the Process Payments window.</td>
<td>Credit Card</td>
</tr>
<tr>
<td>IEX: Default Tab in Collections</td>
<td>Collections</td>
<td>Choose the Collections window tab to appear when the user first opens the Collections window.</td>
<td>Coll Profile</td>
</tr>
<tr>
<td>IEX: Default Transaction Type</td>
<td>Transactions</td>
<td>Enter the transaction type to be the default that is displayed on the Pay Invoices tab of the Collections window.</td>
<td></td>
</tr>
<tr>
<td>IEX: Dispute Confirmation Letter</td>
<td>Fulfillment</td>
<td>Select the Fulfillment template to be sent to customer as a confirmation when a dispute is recorded. For this to work, IEX: Auto Fulfill must also be set to yes.</td>
<td></td>
</tr>
<tr>
<td>IEX:EA Notification Email Subject</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEX:EA Recall Grace Days</td>
<td>Lease Management</td>
<td>After the elapse of the period for which the case has been transferred to an external agency and if there has been no significant positive change in the case score, the external agency will be informed about intent to recall and will be given a grace period to respond to this notification. This grace period is determined by the value in this user profile.</td>
<td></td>
</tr>
<tr>
<td>IEX:EA Score Diff For Recall</td>
<td>Lease Management</td>
<td>A concurrent API will compare the scores of a case after the expiration of the transfer period to determine eligibility for recall. If the positive difference in scores is less than the value in this user profile, then a case will be considered for recall and a notification will be sent to the concerned external agency.</td>
<td></td>
</tr>
<tr>
<td>IEX:EA Score Engine ID</td>
<td>Lease Management</td>
<td>The id of the scoring engine, which is used to score cases for the transfer to external agency process.</td>
<td></td>
</tr>
<tr>
<td>IEX:EA Transfer Days</td>
<td>Lease Management</td>
<td>The number of days, for which a case is transferred to an external agency, after which it is considered for review in case there is no significant positive change in the case score. If the review date is not specified in the Transfer to External Agency screen, when a case is transferred to an external agency, this value is used to generate the review date.</td>
<td></td>
</tr>
<tr>
<td>IEX:EA Vendor Notification Email From</td>
<td>Lease Management</td>
<td>The FROM EMAIL ID of the email sent to the external agency, by the concurrent notification API, to notify about intent to recall the case or a case recall.</td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEX: EA Vendor Notification Email Subject</td>
<td>Lease Management</td>
<td>Subject of the email sent to the external agency, by the concurrent notification API, to notify about intent to recall the case or a case recall.</td>
<td></td>
</tr>
<tr>
<td>IEX: EA Vendor Notification Template</td>
<td>Lease Management</td>
<td>Content id of the notification template that is used to inform the external agency of the intent to recall a case, which has been assigned to them, or to inform the external agency about a case recall. It has to be populated with the content id of the template after the template has been created in Fulfillment. This is used by the concurrent notification API to generate an email, which is sent to the external agency to notify about intent to recall the case or a case recall.</td>
<td></td>
</tr>
<tr>
<td>IEX: Electronic Funds Transfer Payment Remittance</td>
<td>Payment</td>
<td>Specify the payment method set in AR that corresponds to this remittance type.</td>
<td></td>
</tr>
<tr>
<td>IEX: Enable Credit Card Payment</td>
<td>Payment</td>
<td>Choose yes or no to enable the credit card tab in Processing Payments.</td>
<td></td>
</tr>
<tr>
<td>IEX: Enable Electronic Funds Payment</td>
<td>Payment</td>
<td>Choose yes or no to enable the electronic transfer tab in Processing Payments.</td>
<td></td>
</tr>
<tr>
<td>IEX: Enable Promise to Pay</td>
<td>Promise to Pay</td>
<td>Choose yes or no to enable the promise to pay tab in Processing Payments.</td>
<td></td>
</tr>
<tr>
<td>IEX: Enable Receipt Reversal</td>
<td>Payment</td>
<td>If Yes, allows a collector to process a Reversal. If No, then the Reversal button is grayed out.</td>
<td></td>
</tr>
<tr>
<td>IEX: Fulfillment Printer</td>
<td>Fulfillment</td>
<td>The printer name must be the registered printer name in the Fulfillment Server.</td>
<td></td>
</tr>
<tr>
<td>EX: Invoice Fulfillment Template</td>
<td>Fulfillment</td>
<td>Enter the template to be used to send a copy of the invoice from Transaction Details.</td>
<td></td>
</tr>
<tr>
<td>IEX: iPayment Payee ID</td>
<td>Payments</td>
<td>Enter your account number with the payment processing vendor.</td>
<td></td>
</tr>
<tr>
<td>IEX: Item Type of Promise Workflow</td>
<td>Promise</td>
<td>Name of the workflow launched for the promise approval. (None is seeded.)</td>
<td></td>
</tr>
<tr>
<td>IEX: Maximum Promise to Pay Range</td>
<td>Dunning</td>
<td>Set the maximum number of days to wait for a promise to pay to be processed before a followup task is created.</td>
<td></td>
</tr>
<tr>
<td>IEX: Payment Confirmation Letter</td>
<td>Fulfillment</td>
<td>Select the Fulfillment template to be sent to customer as a confirmation when a payment is recorded. For this to work, IEX: Auto Fulfill must also be set to yes.</td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEX: Pay Reversal Confirmation Letter</td>
<td>Fulfillment</td>
<td>Select the Fulfillment template to be sent to customer as a confirmation when a payment reversal is recorded. For this to work, IEX: Auto Fulfill must also be set to yes.</td>
<td></td>
</tr>
<tr>
<td>IEX: Promise Grace Period</td>
<td>Promise to Pay</td>
<td>Grace period after the promise is due before it is considered a broken promise.</td>
<td></td>
</tr>
<tr>
<td>IEX: Promise to Pay Confirmation Letter</td>
<td>Fulfillment</td>
<td>Select the Fulfillment template to be sent to customer as a confirmation when a payment is recorded. For this to work, IEX: Auto Fulfill must also be set to yes.</td>
<td></td>
</tr>
<tr>
<td>IEX: Service Hold of Delinquencies &amp; Lease Management</td>
<td>Delinquency and Lease Management</td>
<td>Set to Yes if you are using Lease Management. Set to No if you are not. No disables the service hold check box on the Delinquency tab.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: Strategy Assignment Default Resource</td>
<td>Strategy</td>
<td>The resource name (of a person) who will be assigned if no resource match the work item specifications.</td>
<td></td>
</tr>
<tr>
<td>IEX: Strategy Dunning History</td>
<td>Strategy</td>
<td>The dunning notifications that are sent via Fulfillment as a result of Strategies will be written to Dunning History when profile is Yes.</td>
<td>Yes</td>
</tr>
<tr>
<td>IEX: Strategy Fulfilment Resource</td>
<td>Strategy</td>
<td>The resource name who has been set up to send a request through the 1-to-1Fulfillment Server.</td>
<td></td>
</tr>
<tr>
<td>IEX: Strategy Grace Period</td>
<td>Strategy</td>
<td>Number of days to wait until escalating a non-completed work item.</td>
<td></td>
</tr>
<tr>
<td>IEX: Strategy UWQ Work Creation</td>
<td>Strategy</td>
<td>If set to yes, then the strategy work items are added to the UWQ Worklist Node and the UWQ Strategy Node. If set to no, then the strategy work item will not be added to UWQ Worklist node.</td>
<td></td>
</tr>
<tr>
<td>IEX: Turn off Collections Activity for Bankruptcy</td>
<td>Lease Management</td>
<td>If no then continue collections activities. If yes then everything is turned to bankruptcy status, new delinquencies are created for non-delinquent cases and then turned to bankruptcy so all collections activities are stopped.</td>
<td></td>
</tr>
<tr>
<td>IEX: Turn off Invoicing for Bankruptcy</td>
<td>Lease Management</td>
<td>When the Flag is set on the Bankruptcy screen, this profile is used. If the profile is set to yes IEX makes a call to OKL to determine if the invoicing should be stopped. If set to no, then IEX does not make a call.</td>
<td></td>
</tr>
<tr>
<td>IEX: UWQ Default Complete Node days</td>
<td>Universal Work Queue</td>
<td>Enter the number of days the item will stay in the Complete node before it is removed.</td>
<td></td>
</tr>
</tbody>
</table>
### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>IEX: UWQ Default Pending Days</td>
<td>Universal Work Queue</td>
<td>Enter the number of days the objects will stay in the Pending node before moving to the Active Node.</td>
<td></td>
</tr>
<tr>
<td>OTS: Interaction Auto Wrapup Enabled</td>
<td>Interaction</td>
<td>When this profile is set to No, the wrap-up window appears automatically prompting users to enter the outcomes and reasons for the activity. When this profile is set to Yes, then the interaction ends automatically without the users seeing the wrap-up window.</td>
<td>No</td>
</tr>
<tr>
<td>OTS: Interaction Default Action</td>
<td>Interactions</td>
<td>Users must perform at least one activity for the interaction to end. If user doesn’t perform any activity but ends the interaction anyway, then the application uses the default action set in this profile and the default action item from the profile OTS: Interaction Default Action Item.</td>
<td>Action with action id = 1 (Item Added)</td>
</tr>
<tr>
<td>OTS: Interaction Default Action Item</td>
<td>Interactions</td>
<td>The application uses the default action item set in this profile together with the default action set in the profile OTS: Interaction Default Action whenever the user does not perform an action required to wrap up an interaction.</td>
<td>Action item with action item id = 1 (Account)</td>
</tr>
<tr>
<td>OTS: Interaction Default Outcome</td>
<td>Interactions</td>
<td>This profile determines the default value of the Outcome field in the wrap-up widow. This is also the value the application uses for outcomes of interactions that are ended automatically. The application uses this value if there is no outcome associated with the campaign schedule for this interaction. If there is a campaign associated with the interaction, then the application uses the outcome for that campaign schedule.</td>
<td>Outcome with outcome id = 1 (No Answer)</td>
</tr>
<tr>
<td>OTS: Max Interactions Displayed</td>
<td>eBusiness Center</td>
<td>Determines how many interactions to display in the overview tab.</td>
<td></td>
</tr>
<tr>
<td>OTS: Interactions -Record Media Item ID</td>
<td>Interactions</td>
<td>Interactions track different types of communications with customers including e-mails and phone calls placed via Oracle inbound and outbound telephony applications. The record includes a unique identifier for the communication. This profile determines if that unique identifier is recorded or not. This identifier is never displayed for the user.</td>
<td>Yes</td>
</tr>
<tr>
<td>OTS: Telesales Interaction Enabled</td>
<td>Interactions</td>
<td>If set to Yes, TeleSales records interactions after the interaction is started. A setting of No limits agents to starting and ending interactions manually.</td>
<td>No</td>
</tr>
</tbody>
</table>
Setting Up Oracle Collections System Profiles

Guidelines

Profile options can be set at four different levels:

- **Site**: Indicates that the profile option is set at the site level. The site level setting affects the entire database. The Value is either Yes or No.

- **Application**: Indicates that the profile option is set at the application level. When a profile option is set at this level it overrides the site level setting. The Value is either Yes or No.

- **Responsibility**: Indicates that the profile option is set at the responsibility level. The responsibility level setting affects users of a given responsibility. When a profile option is set at this level it overrides site and application level settings. The Value is either Yes or No.

- **User**: This setting affects individual users. When set, it overrides values set at the site, application, and responsibility levels. The Value is either Yes or No.

The profile options which can be used for Oracle Collections have the following prefixes:

- **OTS**: (Oracle TeleSales)

  See the *Oracle TeleSales Implementation Guide* for further explanation for the OTS profiles.

- **IEX**: (Oracle Collections)

- **IEU**: (Oracle Universal Work Queue)

### Oracle Collections System Profile Options

<table>
<thead>
<tr>
<th>User Profile Name</th>
<th>Affects</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>OTS: Telesales Interactions On Query Enabled</td>
<td>Interactions</td>
<td>A setting of Yes starts an interaction whenever the user displays a new record. A setting of No starts the interaction only when the user updates or deletes information in a record.</td>
<td>No</td>
</tr>
<tr>
<td>OTS: Telesales On Query Enabled Interactions</td>
<td>Interactions</td>
<td>A setting of Yes starts an interaction whenever the user displays a new record. A setting of No starts the interaction only when the user updates or deletes information in a record.</td>
<td>No</td>
</tr>
<tr>
<td>IEX: DEBUG LEVEL</td>
<td>Internal use</td>
<td>Do not change this profile.</td>
<td></td>
</tr>
</tbody>
</table>
4.27 Set Up Delinquency Prioritization Status

The Collections Header includes one Status field for the customer. This status represents the most critical status of the customer and indicates to the collector what delinquency issues this customer has. Often, the status of Bankruptcy is the most critical and the company using Oracle Collections identifies the prioritization of the various statuses using the Delinquency Status Prioritization menu item. Companies navigate to the Customer Status Stratification Filter from this menu to create their prioritization.

If, for your company, a customer bankruptcy takes precedence over other delinquency statuses, then you make bankruptcy your first status priority. Perhaps litigation is your next highest status. So you make litigation your second highest priority and continue identifying your priorities for each status.

You can also filter your customers by location. Then you can set status prioritization for all United States customers so that bankruptcy is number one priority and litigation is number 2. You can set a separate prioritization for customers in Canada so that litigation has first priority and bankruptcy is number 2. If a customer in Canada does not have a litigation status but does have a bankruptcy status, then Bankruptcy appears in the header.

Use this procedure to set up filters and priorities that control the status displayed in the header for each customer.

**Prerequisites**
If you want to use a filter, the view must be created to filter on.

**Login**
Log in to Oracle HTML Applications

**Responsibility**
Collections HTML Administrator

**Steps**
1. Select the Administration tab.
2. Choose Customer.
   The Delinquency Status Prioritization page lists existing prioritizations with their start and end dates.
3. Click Create.
The Create Delinquency Status Prioritization page appears.

4. Enter a name.
5. Enter a description.
6. Enter start and end dates for the prioritization to be active.
7. Click Create.

The prioritization is saved and appears in the Delinquency Status Prioritization page.

8. If you want to associate a filter with this prioritization, then perform the following steps:
   a. In the Filter Name column, click Create.
      The Filter page appears and the filter type is IEXCUST.
   b. Enter a filter name.
   c. If you want the filter to be active, select Y.
   d. Select the view name to use for the filter from the LOV.
   e. Select the column name to filter on from the LOV.
   f. Click Update.

   The filter is saved and the Delinquency Status Prioritization page appears.

9. Click the Prioritization ID.
   The Status Prioritization Details page appears.

10. Click Add Line.
    Several blank lines appear.

11. From the Delinquency Status LOV, choose the status that will be the first priority.

12. In the Priority field, enter 1.0

13. Select Y to enable the delinquency line.

14. Optionally, enter additional status lines for priority 2, 3, and so on.

15. Click Update.

   Your record is saved.
4.28 Enabling Web Directory Assistance

You set parameters that the application uses to build the URL to automatically send a query to your chosen directory assistance web site. Use this procedure to set the parameters.

**Prerequisites**
None

**Login**
Log in to Oracle HTML Applications.

**Responsibility**
Collections Administrator HTML

**Navigation**
Administration > Sales > Call Center > Web Assistance

**Steps**
The Web Assistsances page appears.
1. Click **Create Web Assistance**.

The Create Web Assistance page appears.
2. Using another browser window, navigate to the web directory assistance service you want to use.

3. Perform a search for any individual. For example, for John Doe in California. Keep the page with the results open. You will need to refer to it for the rest of this procedure.

   For example, navigate to www.superpages.com, select the People Pages tab, and search for John Doe in California.

   The search returns a page with the following URL:


4. In the Proxy Host field, enter the name of your organization’s proxy server.

5. In the Port field, enter the port number for the proxy server.

6. In the Search URL field, enter the part of the URL before the question mark (?).

   In the SuperPages.com example, you copy and paste the following:

   http://wpg2.superpages.com/wp/results.phtml

7. In the Header Constant field, enter the part of the CGI portion of the URL header that remains constant when you perform different searches.
Enabling Web Directory Assistance

**Note:** You may need to perform additional searches to determine what portion of the URL remains constant.

In the SuperPages.com example this is: `SRC=&STYPE=WS&PS=15&PI=1`.

8. In the Trailer Constant field, enter the constant part of the URL after the search terms.

In the SuperPages.com example this is:
```
&search=Find&pow=0&rtd=wpg1.superpages.com.
```

9. Enter the switch separator. The switch separator is always the ampersand (`&`).

10. Enter the URL separator. The URL separator is always the question mark (`?`).

### Create Web Assistance

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Yes</td>
</tr>
<tr>
<td>Directory Assistance Flag</td>
<td>Yes</td>
</tr>
<tr>
<td><code>Proxy Host</code></td>
<td><code>proxy.com</code></td>
</tr>
<tr>
<td><code>Proxy Port</code></td>
<td>80</td>
</tr>
<tr>
<td><code>Search URL</code></td>
<td><code>http://wpg2.superpages</code></td>
</tr>
<tr>
<td>Header Constant</td>
<td><code>SRC=STYPE=WS&amp;PS=15&amp;PI=1</code></td>
</tr>
<tr>
<td>Trailer Constant</td>
<td><code>&amp;search=Find&amp;pow=0&amp;rtd=wpg1.superpages.com</code></td>
</tr>
<tr>
<td><code>Switch Separator</code></td>
<td><code>&amp;</code></td>
</tr>
<tr>
<td>URL Separator</td>
<td><code>?</code></td>
</tr>
</tbody>
</table>

* indicates required field.

[Update] [Restore]

11. Click Update.

The Web Assistance page displays the web assistance you saved.
12. Click **Detail** for the web assistance you created. The Web Assistance Details page appears.

<table>
<thead>
<tr>
<th>Web Assistance Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CGI Switches</strong></td>
</tr>
<tr>
<td>Web Assistance ID: 1000</td>
</tr>
<tr>
<td>Enabled: Y</td>
</tr>
<tr>
<td>Directory Assistance Flag: Y</td>
</tr>
<tr>
<td><strong>Proxy Host</strong>     proxy.com</td>
</tr>
<tr>
<td><strong>Proxy Port</strong>      80</td>
</tr>
<tr>
<td><strong>Search URL</strong>      <a href="http://www2.superpages">http://www2.superpages</a></td>
</tr>
<tr>
<td><strong>Header Constant</strong> SRC=STYPE=WS&amp;F</td>
</tr>
<tr>
<td><strong>Trailer Constant</strong> searchField&amp;port=US</td>
</tr>
<tr>
<td><strong>Switch Separator</strong> &amp;</td>
</tr>
<tr>
<td><strong>URL Separator</strong>   ?</td>
</tr>
</tbody>
</table>

13. Click **CGI Switches**.

The Oracle Collections Web Directory Administration page displays switch information for the web directory.
14. Create each switch to include in the search. The switches are the CGI script variables used for your search criteria. Each switch is followed by an equals (=) sign. In the SuperPages.com example these are: WF, WL, T, and S. For each switch:

a. Click Create.

The Create CGI Switch page appears.
b. Enter the switch in the Switch Code field. The entry is case sensitive.
c. Enter a number in the Sort Order field indicating the order this switch appears in the URL.
d. Enter plus (+) for the data separator.
e. Select Y next to the search criteria related to this switch. For SuperPages.com WF is used for first name, WL for last name, T for city, and S for state.
f. Set the Enable field to Y. Any disabled switch has a corresponding disabled field on the Directory Assistance page.
g. If user entry for this switch is required by the web assistance service, then select Y for the Required field. Look on the search web page to find out what fields are required. In the SuperPages.com example last name is the required field.
h. Click **Update**.

The Web Assistance Details page displays the new switch.

15. After testing your settings, set Enabled to Y.

---

**Note:** You can enable only one service at a time.

16. Select yes or no for the directory assistance flag. Only one web directory can be used for directory assistance.

17. Click **Update** to save your changes.

### 4.29 Running Concurrent Programs

Oracle Collections uses concurrent programs to run batch processes behind the scenes. The administrator is responsible for setting up the parameters of each concurrent program to run. Each concurrent program runs at the lowest responsibility level, and can be set to run at multiple responsibility or organization levels. For example, administrators can login by country (different responsibilities) and set different parameters to use when running the same concurrent program. The default is set to run at the site level.

For detailed instructions for running and maintaining concurrent programs, refer to the *Oracle Applications User’s Guide* and the *Oracle Applications System Administrator’s Guide*.
You can stop concurrent processes at any time. All collections concurrent programs run through one node in the Concurrent Manager. Set up the frequency for running the following Collections sets of concurrent programs:

- **IEX: Promise Reconciliation**: Verifies that promises made were kept or broken. Made payment or didn’t. It considers grace days.

- **IEX: Score Engine Harness**: You can pick from one to five scoring engines in the parameters. If the scoring engine is related to a concurrent program, the concurrent program is also run.

- **IEX: Age Delinquencies**: You can pick up to five aging buckets for the parameters. No grace time applies to promises to pay. Two profile options are used in this concurrent program:
  - **IEX: Promise Grace Period**: number of days for a promise grace
  - **IEX: Maximum Promise to Pay**: maximum number of days from the due date of the OKL invoice or payment schedule that one can make a promise.

- **IEX: Delinquency Management (IEXDLMGB)**: This concurrent program is related to the seeded scoring engines 2 and 3. Creates and closes delinquencies. It takes the scores from the scoring engines and updates the delinquencies table.

- **IEX: Delinquency Scoring**: This concurrent program is related to the seeded scoring engines 4 and 5. It moves the most recent scores to a separate table to improve speed.

- **IEX: Strategy Management**: This concurrent program assigns the appropriate strategy to delinquencies and pre-delinquencies, and closes completed strategies and strategies for cured delinquencies.

**Guidelines**

There is a seeded Concurrent Program Request set that is used to submit the required concurrent programs to be executed on a daily basis for the standard Oracle Collections implementation. If administrators create new scoring engines for Lease Management implementations, then the required concurrent programs will have to be individually submitted. They should be submitted in the same order and the administrator should confirm one program is completed before the next is submitted to ensure accurate processing.

### 4.29.1 Concurrent Programs for Oracle Lease Management

Following are concurrent programs used by Lease Management.
4.29.1.1 IEX: Process Pending

Records are inserted into the open interface with a pending status, as part of the Report to Credit Bureau, Transfer to External Agency, with only the mandatory fields populated. This concurrent program then populates the rest of the information and updates the status of the record to indicate that it has been processed.

Parameters

Object Type: This specifies the type of objects, which are to be processed. Currently it is defaulted to OKX_LEASE. As part of future enhancements, the underlying API can be extended to process other object types. This parameter is mandatory.

Case Number: This specifies the case number of the records to be processed. This parameter is optional. If this parameter is populated, only records belonging to that case will be processed.

4.29.1.2 IEX: Notify Customer

Customers will be notified of the intent to report them to the credit bureau through the Report to Credit Bureau Screen. Pending notifications are created in the open interface, which are then processed. This API will then send notifications to the customer, using fulfillment.

Parameters

Object Type: This specifies the type of objects, which are to be processed by this API. Currently it is defaulted to OKX_LEASE. As part of future enhancements, the underlying API can be extended to process other object types. This parameter is mandatory.

Case Number: This specifies the case number of the records to be processed. This parameter is optional. If this parameter is populated, only customers assigned to that case are notified.

Party Id: This specifies the party id of the records to be processed. This parameter is optional. If this parameter is populated, notifications are sent out only for those cases belonging to this party id.

Agent Id: This parameter is necessitated by the call to fulfillment. If it is not provided, a user profile value will be used.

Content Id: This identifies the fulfillment template that is used for customer notification. If it is not provided, a user profile value will be used.
From: This is the FROM EMAIL ID of the email sent to the customer, by concurrent notification API, to notify about intent to report to the credit bureau. If it is not provided, a user profile value will be used.

Subject: This is the subject of the email sent to the customer, by concurrent notification API, to notify about intent to report to the credit bureau. If it is not provided, a user profile value will be used.

Email: This parameter is provided in case a notification is to be sent to a single customer (run the concurrent program on an ad hoc basis). If this parameter is specified, then the case number parameter must be specified along with this.

4.29.1.3 IEX: Notify Recall Ext Agency
Used to inform the external agency of the intent to recall a case, which has been assigned to them. A pending notification will be created for the external agency. If the REVIEW BEFORE RECALL FLAG (for a case) is set, a review task will be created so that the case can be reviewed and a decision can be made about the case recall.

Parameters
Object Type: This specifies the type of objects, which are to be processed by this API. Currently it is defaulted to OKXLEASE. As part of future enhancements, the underlying API can be extended to process other object types. This parameter is mandatory.

Case Number: This specifies the case number of the records to be processed. This parameter is optional. If this parameter is populated, only customers assigned to that case are notified.

External Agency Id: This parameter is provided in case this program is to be run for a single external agency (run the concurrent program on an ad hoc basis).

Comments: This parameter is provided when this program is run for a single external agency (run the concurrent program on an ad hoc basis). A comment can be entered using this parameter.

4.29.1.4 IEX: Recall From Ext Agency
Recalls a case from an external agency. Cases marked for recall, are actually recalled by this program.
Parameters
Object Type: This specifies the type of objects, which are to be processed by this API. Currently it is defaulted to OKXLEASE. As part of future enhancements, the underlying API can be extended to process other object types. This parameter is mandatory.

Case Number: This specifies the case number of the records to be processed. This parameter is optional. If this parameter is populated, only the external agency, to which the case is assigned, is notified.

External Agency Id: This specifies the external agency id of the records to be processed. This parameter is optional. If this parameter is populated, notifications are sent out only to this external agency.

Agent Id: This parameter is necessitated by the call to fulfillment. If it is not provided, a user profile value will be used.

Content Id: This identifies the fulfillment template that is used for external agency notification. If it is not provided, a user profile value will be used.

From: This is the FROM EMAIL ID of the email sent to the external agency, by concurrent notification API. If it is not provided, a user profile value will be used.

4.29.1.5 IEX: Notify Ext Agency
Used to inform the external agency about the recall of a case, which has been assigned to them. A pending notification will be created for the external agency.

Parameters
Object Type: This specifies the type of objects, which are to be processed by this API. Currently it is defaulted to OKXLEASE. As part of future enhancements, the underlying API can be extended to process other object types. This parameter is mandatory.

Case Number: This specifies the case number of the records to be processed. This parameter is optional. If this parameter is populated, only customers assigned to that case are notified.

External Agency Id: This parameter is provided in case this program is to be run for a single external agency (run the concurrent program on an ad hoc basis).

Comments: This parameter is provided when this program is run for a single external agency (run the concurrent program on an ad hoc basis). A comment can be entered using this parameter.
Subject: This is the subject of the email sent to the external agency, by concurrent notification API. If it is not provided, a user profile value will be used.

Email: This parameter is provided in case a notification is to be sent to a single external agency (run the concurrent program on an ad hoc basis). If this parameter is specified, then the case number parameter must be specified along with this.

4.29.1.6 Generate Cure Amount
This concurrent program Calculates Cure and Repurchase Amounts for contracts that have gone delinquent. The program uses Rules to determine the cure amounts. These amounts are used to generate cure request to vendors.

Parameter
Contract Number: The program can be run for a specific contract to generate cure or repurchase amounts. If the value is null, the program generates amounts for all delinquent contracts.

4.29.1.7 Generate Cure Refund
This concurrent program collates refund amounts for contracts that vendors have cured. The amounts are summed up per contract.

Parameter
Contract Number: The program can be run for a specific contract to generate refund amounts. If the value is null, the program generates amounts for all cured contracts.

4.29.1.8 Send Cure Request
This concurrent program sends cure requests to vendors via fulfillment. It uses the fulfillment template defined in fulfillment server. If none of the parameters are specified the program sends request to all vendors that have approved requests in the system.

Parameter
Vendor Number: Specifies which vendor gets the sure request.
Report Number: Specifies which request to send.
Report Date: Specifies date for which requests are picked up.
Agent Id: This parameter is necessitated by the call to fulfillment. Specifies which agent ran the fulfillment request.
Content Id: This identifies the fulfillment template that is used for a request.
From: This is the FROM EMAIL ID of the email sent to the vendor.
Subject: This is the subject of the email sent to the vendor.
Email: This parameter is provided in case a notification is to be sent to a single vendor.
Part III
Post Implementation Tasks

This section of the Oracle Collections Implementation Guide contains the following chapters:

- Chapter 5, "Verifying the Implementation"
Verifying the Implementation

This chapter discusses ways you can verify that your implementation of Oracle Collections was successful and includes the following topics:

- Section 5.1, "Use the Diagnostic Tests"
- Section 5.2, "Implementation Verification Tasks for Mandatory Components"
- Section 5.3, "Implementation Verification Tasks for Optional Components"

### 5.1 Use the Diagnostic Tests

After completing the implementation steps of the Application CRM Foundation module, run the entire suite of diagnostic tests available through the HTML Administrator Console. Implementors would most likely either verify using the Basic tab or the Advanced tab. In the Basic tab, you can run the following tests:

- RunAll
- UserTest
- AOLTests
- PropertyManager
- UserProfile
- AKData
- Security Manager

In the Advanced tab, you can modify the parameters used in the previously mentioned tests.

Each test generates a report if a problem is encountered. The report identifies the problem and provides a suggested resolution to the problem.
5.2 Implementation Verification Tasks for Mandatory Components

Perform the tasks in this section to verify the implementation of the mandatory components of Oracle Collections.

Prerequisites

The following setups are needed for performing the verification tasks:

1. Create Fulfillment Collections Items
   a. Dunning Letters
   b. Follow Up Payment and Dispute Templates
   c. Send Copy of Invoice template
2. Create Scoring Components
3. Create Scoring Engine
   a. Select Components
   b. Weight Components
4. Create Dunning Plan
   a. Create Plan per Aged Bucket
   b. Select Dunning Letter
   c. Determine (use E-mail) Letter Fulfillment
   d. Determine Call Back Requirements (Select yes for testing)
5. Configure A/R Credit Memo Workflow

Tasks

1. Section 5.2.1, "Create Accounts"
2. Section 5.2.2, "Create Invoices"
3. Section 5.2.3, "Create Delinquencies"
4. Section 5.2.4, "Verify Delinquencies"
5. Section 5.2.5, "Dispute an Invoice"
6. Section 5.2.6, "Record a Promise to Pay"
7. Section 5.2.7, "Process a Credit Card Payment"
8. Section 5.2.8, "Process a Bank EFT Payment"
9. Section 5.2.9, "Process the Collections Activities"
10. Section 5.2.10, "Verify Payment Processing"
11. Section 5.2.11, "Verify the Collector’s Actions"
12. Section 5.2.12, "Verify Universal Work Queue Navigation"
13. Section 5.2.13, "Verify Query Navigation"
14. Section 5.2.14, "Verify Interaction Tracking"

5.2.1 Create Accounts
Create some test accounts tied to existing customers.

Login
Log in to Oracle Forms.

Responsibility
Collections Agent
Collections Manager

Steps
1. Navigate to the eBusiness Center.
2. Search and select a customer.
3. Navigate to the Account tab.
4. Click New.
5. Enter account information
6. Enter your e-mail address as the primary bill to address.
7. Save. Keep a note of the customer name and account number.
8. Repeat for two more accounts. Add the customer names and account numbers to your note.

Guidelines
Creating accounts can also be done in Oracle Receivables.
You should create several accounts so that you can verify individual account information is reflected accurately in the Collections Header as well as in the Aging Buckets and Delinquency table views on the Profile tab.

In order to test the Dunning and Fulfillment functions, enter your e-mail address as the Primary Bill To address. By doing this, once the Dunning Plan is executed, you will be able to verify that the appropriate dunning letter with the appropriate data is received.

5.2.2 Create Invoices

Create invoices complete with line items and amounts, and then make them due immediately so that they will be flagged as delinquent when the Concurrent Program requests are submitted. Here is where you create the individual invoice lines, compute tax, and then complete the invoices. Then you are ready to request Concurrent Programs so that these invoices are aged and will become delinquencies.

Login
Log in to Oracle Forms.

Responsibility

Receivables, Vision Operations (or a comparable responsibility in a test or live environment)

Steps
1. From the Navigator open Transactions and choose Transactions.
2. Enter a free form invoice number.
   Source defaults to BR Manual.
3. Select Invoice type.
4. Select Invoice class.
5. For Terms select IMMEDIATE.
   This creates an immediate delinquency.
6. Enter Invoice Lines using the following steps for each line:
   a. Choose Line Items.
The Line window appears.

b. Enter item, description, quantity, and unit price.

c. Close Lines window.

d. Click Tax.

e. Click Complete.

Guidelines
Make the line items on each invoice different and remember what the totals are so that you can verify amounts on the Collections Header and Profile tab.

5.2.3 Create Delinquencies

Delinquencies are Oracle Collections Business Objects that become the collector’s work items. You will need to run the Concurrent Program Request Set to create delinquencies and score customers. The aged invoices just created are flagged as delinquent, become delinquencies in the Oracle Collections tables. Once a customer has delinquencies, they are scored. Once scored, the Dunning Plan executes and the appropriate letters and dunning call backs are created.

Login
Log in to Oracle Forms.

Responsibility
Collections Forms Administrator

Steps
1. From the View menu, choose Requests.
   The Find Request window appears.
2. Click Submit a New Request.
3. Select Request Set.
4. Click OK.
5. Select Create Delinquencies and Score Collections Customers.
6. Leave Schedule set to As Soon As Possible.
7. Click Submit.
8. Review request sets and refresh screen to monitor.

5.2.4 Verify Delinquencies

At this time, you can verify if delinquencies were accurately created and if all of the dependent processes occurred.

**Login**

Log in to Oracle Forms.

**Responsibility**

Collections Agent

Collections Manager

**Steps**

1. Go to Universal Work Queue and see if the invoices that are now delinquent appear in UWQ in the Delinquency Node and if appropriate Dunning Call Backs and Letters are noted in the Dunning Node.

2. Navigate to the Collections window.

3. Can you find all of your delinquencies in the Collections Header? Switch account views to verify delinquent amounts, number of invoices, and the collections score.

4. View by Delinquency and verify that each delinquency appears in the Profile tab.

5. Select to view Aging Buckets and check the totals. (All delinquencies most likely appear in the first bucket.

6. In the Pay Invoices tab, switch between each account and see if the delinquent invoices appear.

7. Click the customer’s name (Organization).

   The eBusiness Center displays the customer information.

8. Select the Collections tab and make sure the information is the same as on the Profile tab.

9. Return to the Collections window and navigate to the History tab.

10. Select the Dunning History.
You should see the dunning events that have occurred. These are the dunning letters that should have been e-mailed to you when the concurrent programs were run.

11. Check your e-mail. Did you receive a dunning e-mail for each delinquent invoice? Verify the contents of the letter and ensure the delinquent amounts and the invoice number due date are accurately reflected.

5.2.5 Dispute an Invoice

Verify that a collections agent can record a dispute for an invoice.

Login
Log in to Oracle Forms.

Responsibility
Collections Agent
Collections Manager

Steps
1. Select the customer.
2. In the Pay Invoices tab, select an invoice.
3. Click Transaction Details.
4. Enter a dispute reason.
5. Enter a dispute quantity or amount.
6. Enter a note.
7. Click Submit.
   Oracle Collections calls the Oracle Receivables Credit Memo Workflow.
8. Click Send Copy.
   A copy of the dispute is e-mailed to you.

Guidelines
Keep a record of your dispute for later verification.
5.2.6 Record a Promise to Pay

Process the second delinquent invoice as a Promise to Pay. Collectors are not actually taking money from their customer at this point, but rather getting the customer to agree to pay in the future. This is a very common approach to collections.

Login
Log in to Oracle Forms.

Responsibility
Collections Agent
Collections Manager

Prerequisites
Set the profile option IEX: Callback Days for Broken Promise to 0 (zero).
Set the profile option IEX: Enable Promise to Pay to Yes.

Steps
1. Select the customer.
2. In the Pay Invoices tab, select an invoice.
3. Click Payment Processing.
   The Payment Processing window appears.
4. Enter a payment amount.
5. Enter three promise to pay lines, each with a different due date. Make one due date today’s date. Enter three different amounts.
6. Enter a note.
7. Click Submit.

5.2.7 Process a Credit Card Payment

Collectors often take credit card payments in B2C and in some cases for B2B. (Oracle, for example, allows customer to pre-pay their educational classes via credit card). Oracle iPayment will process the credit card information and apply the cash to accounts receivable.
Login
Log in to Oracle Forms.

Responsibility
Collections Agent
Collections Manager

Prerequisites
This requires Oracle iPayment to be fully configured.
Set the profile option IEX: Enable Credit Card Payment to Yes.

Steps
1. Select the customer.
2. In the Pay Invoices tab, select an invoice.
3. Click Payment Processing.
   The Payment Processing window appears.
4. Enter a payment amount.
5. Enter the bogus credit card number starting with 4004 and the rest 1’s so that it will process.
6. Enter the amount to be charged against the credit card. Keep a note of the payment amount for later verification.
7. Enter a note for the payment.
8. Click Submit.
Oracle iPayment will process the credit card information and apply the cash to accounts receivable.

5.2.8 Process a Bank EFT Payment
The final type of payment processing is Bank Electronic Funds Transfer or EFT. Collectors use this type of money transfer to take payments immediately.

Login
Log in to Oracle Forms.
Responsibility
Collections Agent
Collections Manager

Prerequisites
This requires Oracle iPayment to be fully configured.
Set the profile option IEX: Enable Electronic Funds Payment to Yes.

Steps
1. Select the customer.
2. In the Pay Invoices tab, select an invoice.
3. Click Payment Processing.
   The Payment Processing window appears.
4. Enter a payment amount.
5. Enter bank numbers and amounts.
6. Enter a note for the payment.
7. Click Submit.

Similar to credit card payment processing, Oracle Collections calls Oracle iPayment to verify the bank information and to obtain the authorization for the funds transfer.

5.2.9 Process the Collections Activities
The next step is to run the concurrent program to check activities against delinquencies. We have already run the Concurrent Program to create delinquencies and score customers. That program will more than likely be run to coincide with a customer’s billing cycle as dunning letters should be sent on a regularly scheduled basis. The other concurrent program, Collections Daily Batch, is meant to be executed, as the name implies, on a daily basis. This concurrent program will:

- Review payments that have been posted and close delinquencies
- Review promises that have been made, check the grace period, and then reconcile if the payment has been posted
- Create broken promises call back for broken promises
Determine if any delinquencies in dispute have been resolved or disproved and determine next action

**Login**
Log in to Oracle Forms.

**Responsibility**
Collections Manager

**Steps**
1. Select *Concurrent Programs*.
2. Request *Collections Daily Batch*.
3. Click *Refresh* until batch process is completed.
4. Exit.

You are ready to review the collector’s last series of actions and determine if the payment and disputing processes are functioning properly.

### 5.2.10 Verify Payment Processing

At this time, you can verify if the payments and disputes that were attributed to the delinquencies were accurately processed by Oracle Collections and Oracle iPayment, and ultimately posted within Oracle Receivables. Processing payments and disputes is probably the most critical function that the collector performs.

**Login**
Log in to Oracle Forms.

**Responsibility**
Collections Agent
Collections Manager

**Steps**
1. Go to Universal Work Queue and check the following:
   a. Are the two invoices paid by Credit Card and EFT now gone?
b. Is the Promise to Pay (which was broken) now represented in the Broken Promise Node?

c. What is the status of the delinquency that is in Dispute?

2. Navigate to the Collections window and verify the following:

a. Can you find these delinquencies in the Collections Header: switch account views, verify delinquent amounts and number of invoices. Have the cured delinquencies been removed?

b. Move to the Profile tab and verify the delinquencies can be seen in the Delinquency View. Are all of the delinquencies there? Check the Aged Bucket View. Are some of these now gone?

c. Move to the Pay Invoices tab. Switch between each account and see if the delinquent invoices are there. What is the status of the disputed invoice?

3. Click the customer’s name (Organization) to navigate to eBusiness Center. Check the data on the Collections tab.

4. Check your e-mail. Did you receive an e-mail for each payment or dispute processed with the appropriate payment and dispute information included? Did you receive a copy of the invoice as per the request?

If you have been able to successfully verify all of these steps, you can proceed to the next Verification Check Point.

Guidelines
If all points do not verify, check the following:

- Did the Concurrent Programs complete?
- Is your e-mail working?
- Is the Fulfillment engine working?

5.2.11 Verify the Collector’s Actions

At this time, you can verify what the collectors have done and if all of their actions have been recorded in the various histories, if all notes have been saved, and if all payment processing transactions appear in reports.

Login
Log in to Oracle Forms.
Responsibility
Collections Agent
Collections Manager

Steps
1. In the History tab of the Collections window, go to Payment history and verify your credit card and bank EFT payments, including your notes.
2. Go to the Promise to Pay history and verify your recorded promises and related notes.
3. Go to the Dispute history and verify the details of the dispute and your notes.
4. From the Navigator, choose Reports.
   The Collections Reports page appears in a separate browser window.
5. Check the Reconciliation Report to see if the broken promise is noted.
6. Check the Collector Report to see if all payments, promises, and disputes are noted, if invoice information is accurate, and if accounts are noted.
7. Go to the Collections header and look for the information that is on the Collector report. Switch account views and verify delinquent amounts and number of invoices. Have the cured delinquencies been removed?

Guidelines
If all points do not verify, check the following:
- Did the Concurrent Programs complete?
- Are the reports running at all?

5.2.12 Verify Universal Work Queue Navigation
At this time, you can verify if the flows from UWQ are mapped to the correct tab within Oracle Collections. You should check each flow to ensure the collector can efficiently navigate through the application.

Login
Log in to Oracle Forms.
Responsibility
Collections Agent
Collections Manager

Steps
1. From the Navigator, choose **Universal Work Queue**.
   The UWQ window opens.
2. From UWQ Delinquency node select a delinquency and click **Get Work**.
   Does the Collections Pay Invoices tab appear with the selected delinquent invoice highlighted?
3. From UWQ Broken Promise node select a Broken Promise and click **Get Work**.
   Does the Collections Promise History appear with selected broken promise highlighted?
4. From UWQ Dunning node select a Dunning item and click **Get Work**.
   Does the Collections Dunning History appear with selected dunning and invoice highlighted?
5. From Collections window, double-click the Organization ID.
   The eBusiness Center opens. Does is display the right customer information?
6. From the eBusiness Center, click **Details**.
   The Collections window opens. Does it display the right customer information?

Guidelines
If the verification ails, check the Universal Work Queue setup steps.

5.2.13 Verify Query Navigation
At this time, you can verify if the Queries are working and if you can navigate into Collections. Use for your searches the accounts and activities that you created. You may have already validated some of these queries when you were working on setting up the application or performing earlier verification steps. If so, proceed to the next verification step.

Login
Log in to Oracle Forms.
Responsibility
Collections Agent
Collections Manager

Steps
1. From Universal Search, choose Payment search and search by Organization.
2. Select a payment from the results and click Apply. The Collections window displays the selected payment.
3. From Universal Search, choose Dispute search and search by dispute request # or Invoice number.
4. Select a dispute from the results and click Apply. The Collections window displays the selected dispute.
5. Use the flashlight icon to go to Universal Search.
6. Choose Promise search and search by account #.
7. Select a promise from the results and click Apply. The Collections window displays the selected promise to pay.
8. From the Collections window, use the LOVs and:
   a. Search By Identification Number
   b. Search By Last Name
   c. Search By Organization

5.2.14 Verify Interaction Tracking

Interaction Tracking can be manual or automatic. Manual interaction tracking requires the collector to start and stop interactions using the traffic lights on the toolbar. The actions and action items columns are automatically filled in based on where the collector navigates within the application. Automatic interaction tracking begins as soon as a collector selects a record from Universal Work Queue or queries a record (both are based on profiles).

Prerequisites
Set the profile option IEX: Automatically Start Interactions to No.
Login
Log in to Oracle Forms.

Responsibility
Collections Agent
Collections Manager

Steps
1. Query and view a Customer in the Collections window.
2. Click the first traffic light to start the interaction.
3. Process a payment and make note down the details of your transaction.
4. Click the second traffic light to verify actions and to end the interaction.
5. Verify in the eBusiness Center that the interaction is recorded.
6. To change to automatic interaction tracking, change the profile option IEX: Automatically Start Interactions to Yes.
7. In Universal Work Queue, Select a work item and click Get Work.
8. In the Collections window, note that the first traffic light is grey.
9. Process a payment and make note down the details of your transaction.
10. Return to UWQ and select another record.
11. Verify the interaction is recorded in the eBusiness Center.
12. To change to manual interaction tracking, change the profile option IEX: Automatically Start Interactions to No.
13. Query and view a Customer in the Collections window.
14. Click the first traffic light to start the interaction.
15. Process a payment and make note down the details of your transaction.
16. Click the organization name.
   The eBusiness Center opens. Is the party the same?
17. Create a task.
18. Click the second traffic light to view Wrap Up. Are all actions and action items recorded?
19. End the interaction.

20. Re-Query the record in the eBusiness Center. Can you see this interaction and all actions and action items?

Guidelines
Other profile options affect how interaction history behaves. See Section 4.26, "Setting Up Oracle Collections System Profiles" for more information.

5.3 Implementation Verification Tasks for Optional Components

Perform the tasks in this section to verify the implementation of optional components of Oracle Collections.

Prerequisites
Determine if your implementation includes any of the following optional components.

- Oracle Marketing Online and its dependency, Oracle Discoverer
- Oracle Advanced Inbound
- Oracle Advanced Outbound
- Oracle Scripting

Be sure someone on your implementation team has expertise in the optional components you are implementing. Also make sure the components have been installed.

Tasks
Perform the following tasks in sequence:

- Section 5.3.1, "Create Discoverer Workbooks"
- Section 5.3.2, "Create Collections Campaign"
- Section 5.3.3, "Create Collections Script"
- Section 5.3.4, "Verify Advanced Inbound"
- Section 5.3.5, "Verify Advanced Outbound"
- Section 5.3.6, "Verify E-mails"
- Section 5.3.7, "Verify Inbound and Outbound Flows"
5.3.1 Create Discoverer Workbooks

Begin by creating Oracle Discoverer Workbooks that reflect typical collections delinquent segments: aged buckets. Use these as the basis for your Collections Campaigns.

Steps
1. Use a single login to log in to Oracle Discoverer.
2. Create and Aged Bucket Workbook with the following buckets:
   - 30 Day
   - 60 Day
   - 90 Day
   - 120 Day
3. Review the results for each workbook and ensure the 30 day or 60 day segments contain delinquent customers.

5.3.2 Create Collections Campaign

Use the Discoverer Workbooks as the basis for the collections campaigns being created in Oracle Marketing Online. To test multi-channel collections capabilities, use one segment for an e-mail contact and another for the call center channel.

Steps
1. Set up a custom collections campaign.
2. Set up campaign schedules.
3. Define Medium.
4. Set up e-mail for one segment.
5. Set up Call Center for the second segment.
6. Run Concurrent Programs.

Guidelines
Remember to set up the e-mail blast.
Use your e-mail address as the primary e-mail for all customers so you will receive dunning notice.
Make sure you have delinquent accounts for each aged bucket you are trying to test.

5.3.3 Create Collections Script

Next create a script in Oracle Scripting and link to one of the collections campaigns created in the previous step.

Steps
1. Create a collections script that matches the 30 or 60 day delinquency campaign.
2. Load into database.
3. Assign the script to the campaign.
   a. Contact Point = Outbound (or Inbound)
   b. Select script.
   c. Attach at campaign schedule level.
   d. Assign DNIS.
   e. Enable OTS Match.
   f. Set launch script profile option. (Set either OTS: Script Launch on Interaction or OTS: Script Launch on UWQ Delivery.)

Guidelines
Tailor the script to match the segment the script will be used for (such as 30 or 60). You can vary the profiles so the script launches automatically upon an interaction start.

Make a note of the script and campaign schedule so you can verify that the appropriate script is launched.

5.3.4 Verify Advanced Inbound

Verify that the Oracle Advanced Inbound module is ready for collections.

Steps
1. Determine Active or Passive mode.
2. Set up Collections classifications.
3. Set up UWQ Media Classification Action.
4. Set up Routing Rules.

5.3.5 Verify Advanced Outbound
Verify that the Advanced Inbound module is ready for Collections.

Steps
1. Verify OMO Campaign Type = Collections.
2. Verify OMO Campaign Schedule Activity = Telemarketing.
3. Classification = Collections.
4. UWQ Media Action Association = Advanced Outbound Collections.
5. Assign agents to campaigns.

5.3.6 Verify E-mails
Verify that the Oracle Marketing Online eMail Channel executed properly. Because you used your e-mail address as the primary e-mail address for all delinquent accounts, you should have e-mail dunning notices in your inbox. But since we have one delinquent segment targeted for the call center and the other for e-mails, it is important to verify that the emails received were from the appropriate segment.

Steps
1. Log into your e-mail.
2. Look for new Dunning e-mail.
3. Verify the emails are from customers from the e-mail blitz channel. And these dunning e-mails are different than the Dunning Plan items that Collections uses and, therefore, don’t appear in UWQ.

Guidelines
If you have not found the e-mail, then check the following:
- Were the e-mails executed?
- Did the Discoverer Workbook create a list with records?
- Is your e-mail set as primary e-mail address in the delinquent records?
5.3.7 Verify Inbound and Outbound Flows

At this time, you can verify the rest of the optional CRM components. Based on the campaigns which were targeted for the call center, associated scripts, and inbound/outbound set ups, can you work these delinquent customers? If the optional components were configured and set up correctly, you can verify by performing the following checks.

**Steps**

1. Go to UWQ and log into either inbound media node or outbound media node (depending on which one you created) and **Get Work**.  
   
   If CTI is on, the system automatically navigates to Collections.

2. Verify the customer record displayed in Collections was meant for this segment. Do they have a 30 or 60 day delinquency?

3. Launch the script if it is not set to launch automatically. Does the correct customer information populate in the script?

4. Verify the campaign schedule ID (code) is visible.

5. If Interaction Tracking is on, then work the delinquent record and wrap up the record. Another delinquent customer should pop up if CTI is on.

6. If CTI is not present, then perform the following steps:
   
   a. Query a record.
   
   b. Search for the script.
   
   c. Work the delinquency.

If you have been able to successfully verify all of these steps, you have successfully completed the verification of the optional components.

**Guidelines**

If the verification fails, you can check the following:

- Were the scripts loaded into the database and assigned to the campaign?
- Is the campaign active?
- Is the CTI server configured?
This section contains the following appendixes:

- Appendix A, "Lookups"
This appendix provides a table the lookups used by the Oracle Sales Family of eBusiness Suite applications. It includes lookups with three different levels of modification:

- **System (S):** The implementor can only change the wording of a list of values (LOV) choices the user sees on the screen. No deletions or additions are allowed.

- **Extensible (E):** The implementor can change both the wording of the LOV choices and add new choices for the user.

- **User (U):** The implementor can change the lookup completely, deleting and adding LOV choices at will.

For information about viewing and modifying lookups, please refer to the *Oracle Applications System Administrator’s Guide.*
# A.1 Table of Lookups

## Responsibility
Collections Forms Administrator

The following table lists lookups for Oracle Collections, their values or defaults, the areas they affect, and the access level.

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>CREDIT_MEMO_REASON</td>
<td>Dispute Reason</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEX</td>
<td>CODE_STATUS</td>
<td>Active</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_ALL_TYPE</td>
<td>ALL</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_ASSIST_TYPES</td>
<td>PHONE_ASSIST</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_DISPOSITION_CODE</td>
<td>APPROVED: Approved Full Contract</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_DISPUTED_SECTION</td>
<td>LINES_SUBTOTAL, SHIPPING, SPECIFIC_INVOICE_LINES, TAX, TOTAL</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>------------------------</td>
<td>---------------------------------------------</td>
<td>----------------------</td>
<td>-------</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_DISPUTE_REASONS</td>
<td>A/R Error</td>
<td>Disputing Invoices</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Cancellation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>A contact line has been terminated</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Credit and Rebill</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Duplicate Billing</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Free Product</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Freight Error</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Late Payment</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>No Reason Entered</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Order Entry Error</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PA_Credit_Memo</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PA_Write_Off</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Return</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Sales Tax Error</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Shipping and Handling</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tax Exempt</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VAT 0%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VAT 2%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VAT 6.5%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WF_TEST_REASON</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_PAYMENT_TYPES</td>
<td>BA (Electronic Funds Transfer)</td>
<td>Payments</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CC (Credit Card)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_PROMISE_STATUSES</td>
<td>Broken</td>
<td>Promise to Pay</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Fulfilled</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>In Question</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------</td>
<td>--------</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_REPO_DISPOSITION</td>
<td>APPROVED_PEND: Approved / Pending&lt;br&gt;CLOSED: Closed&lt;br&gt;COMPLETE: Complete&lt;br&gt;OPEN: Open&lt;br&gt;REQUESTED: Repossession Requested&lt;br&gt;REJECTED: Rejected</td>
<td>Repossession</td>
<td>U</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_REPO_DISP_REASON</td>
<td>NOT_REPOSSESSED: Asset not repossessed&lt;br&gt;REJECTED: Management Rejected&lt;br&gt;REPOSSESSED: Asset repossessed</td>
<td>Repossession</td>
<td>U</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_TRANSACTION_TYPES</td>
<td>CB (Charge Back)&lt;br&gt;CM (Credit Memo)&lt;br&gt;DEP (Deposit)&lt;br&gt;DM (Deposit Memo)&lt;br&gt;GUAR (Guarantee)&lt;br&gt;INV (Invoice)</td>
<td></td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_UWQ_LABELS</td>
<td>DELINQUENCY_WORK_CLASS_LABEL (My Delinquencies)&lt;br&gt;DUNNING_WORK_CLASS_LABEL (My Dunning)&lt;br&gt;PROMISES_WORK_CLASS_LABEL (My Broken Promises)</td>
<td>Universal Work Queue</td>
<td>U</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_UWQ_NODE_STATUS</td>
<td>ACTIVE&lt;br&gt;PENDING&lt;br&gt;COMPLETE</td>
<td>Universal Work Queue</td>
<td>S</td>
</tr>
<tr>
<td>IEX</td>
<td>IEX_WRITEOFF_DISPOSITION_CODE</td>
<td>APPROVED: Approved&lt;br&gt;CANCELLED: Cancelled&lt;br&gt;PARTIALLY_APPROVED: Partially Approved&lt;br&gt;REJECTED: Rejected&lt;br&gt;REVERSED: Reversed</td>
<td>Write-off</td>
<td>U</td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>------------------------------------------------------------------------</td>
<td>---------------</td>
<td>-------</td>
</tr>
</tbody>
</table>
| IEX  | IEX_WRITEOFF_DISP_REASON | 3RD_PART_EXT: Third Party Assigned (External)  
                                      3RD_PART_INT: Third Party Assigned (Internal)  
                                      CONTINUE_COLLECTIONS: Continue Collections  
                                      CONTRACT_TERMINATED: Contract Terminated  
                                      CREDIT_MEMO_ISSUED: Credit Memo Issued  
                                      INSURANCE_CLAIM: File Insurance claim for lost asset  
                                      LOST_PROVISION_CREATED: Lost Provision Created  
                                      SKIP_TRACE: Send to Skip Trace | Write-off | U     |
## A.2 Table of Lookups

The following table lists lookups for the Sales Family of eBusiness Suite applications, their values or defaults, the areas they affect, and the access level.

<table>
<thead>
<tr>
<th>App. Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASF_CHART_SERIES_COUNT</td>
<td>Number of series to show in a chart.</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>ASF_CHART_VALUE_TYPES</td>
<td>Value type for Y axis in charts (Count/Amount).</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>ASF_MODULE_FUNCTION_ATTR</td>
<td>Lookup for default login page features.</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>ASF_LIST_QUERY.Filters</td>
<td>Detail (Title, Gender, Sales Group)</td>
<td>Contact list filters</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Relationship (Person to Organization, Person to Person, Department Type, Job Title Type, Role)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Address (Country)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Issues (Scheme, Issue Group Types, Currency)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Customer Classification (Class Category)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BUDGET_STATUS</td>
<td>APPROVED (Approved)</td>
<td>Leads budget status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>NOT_APPROVED (Not approved)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>PENDING (Pending)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLOSE_REASON</td>
<td>A (Availability)</td>
<td>Leads close reason</td>
<td></td>
</tr>
<tr>
<td></td>
<td>C (Competition)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>F (Function)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>P (Price)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>S (Service)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table of Lookups

<table>
<thead>
<tr>
<th>App. Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>DECISION_TIMEFRAME</td>
<td>1-3 MONTHS</td>
<td>Leads time frame</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3-6 MONTHS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6-12 MONTHS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>MORE THAN 1 YEAR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>WITHIN 1 MONTH</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>WITHIN 1 WEEK</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LEAD_CONTACT_ROLE</td>
<td>DECISION_MAKER (Decision maker)</td>
<td>Leads contact role</td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_USER (End user)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LINK_TYPE</td>
<td></td>
<td>Lookup for tools</td>
<td>administration page</td>
</tr>
<tr>
<td>PARTY_RELATIONS_TYPE</td>
<td>BENEFACTOR_OF (Benefactor of)</td>
<td>Leads relationship type</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BOARD_MEMBER_OF (Board member of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CONTACT_OF (Contact of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>CUSTOMER_OF (Customer of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>EMPLOYEE_OF (Employee of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>STOCK_HOLDER_OF (Stock holder of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>PARTY_RELATIONS_TYPE</td>
<td>(continued)</td>
<td>MEMBER_OF (Member)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MOTHER_OF (Mother)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OWNED_BY (Owned)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PARENT_OF (Parent)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PARTNER_OF (Partner)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAYFROM_OF (Alternate party to pay for a buyer)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAYTO_OF (Alternate payee name for the seller)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PUBLISHER (Publisher)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REFERENCE_FOR (Reference)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>_OF (Relative)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REPAIR_DEPOT_PROVIDER_FOR (Repair depot provider)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REPORTS_TO (Reports to)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SELLER_FOR (Seller)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SELLER_TO (Seller to)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHIPTO_OF (Alternate shipping party for the buyer)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIBLING_OF (Sibling)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SISTER_OF (Sister)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SON_OF (Son)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SPOUSE_OF (Spouse)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STOCK_HOLDER_OF (Stockholder)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STUDENT_OF (Student)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SUBSIDIARY_OF (Subsidiary)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>THIRD_PARTY_OF (Third party)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNCLE_OF (Uncle)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VAD_OF (VAD of)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VAR_OF (VAR of)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VENDOR_OF (Vendor)</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td></td>
<td>RANK_ID</td>
<td>1 (Cold lead)</td>
<td>Lead rank</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Low lead)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3 (Medium lead)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>4 (Hot lead)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REJECT_REASON_CODE</td>
<td>ASSIGN_ERROR (Assign error)</td>
<td>Leads decline</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DUPLICATE (Duplicate)</td>
<td>reason</td>
</tr>
<tr>
<td></td>
<td></td>
<td>VACATION (Vacation)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SALES_CHANNEL</td>
<td>DIRECT (Direct)</td>
<td>Sales Channel</td>
</tr>
<tr>
<td></td>
<td></td>
<td>INDIRECT (Indirect)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>STATUS_CODE</td>
<td>NEW (new)</td>
<td>Lead status</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UNQUALIFIED (unqualified)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>QUALIFIED (qualified)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ACCEPTED (accepted)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOSS (loss)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEAD_LEAD (dead lead)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DECLINED (declined)</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONVERTED_TO_OPPORTUNITY (lead converted to opportunity)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>VEHICLE_RESPONSE_CODE</td>
<td>EMAIL, FAX, LETTER, PHONE, USER, VOICE_MESSAGES, WEB</td>
<td>Lead response channel</td>
</tr>
<tr>
<td></td>
<td>RELATIONSHIP_TYPE</td>
<td>ALL (seeded value)</td>
<td>Accounts</td>
</tr>
<tr>
<td></td>
<td>TAX_CODE</td>
<td></td>
<td>Accounts</td>
</tr>
<tr>
<td></td>
<td>PAYMENT_TERM</td>
<td></td>
<td>Accounts</td>
</tr>
<tr>
<td>AMS</td>
<td>AMS_EVENTPAYMENT_</td>
<td></td>
<td>Events</td>
</tr>
<tr>
<td></td>
<td>STATUS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>ACCOUNT_STATUS</td>
<td></td>
<td>Accounts</td>
</tr>
</tbody>
</table>
## Table of Lookups

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>ACCT_ROLE_TYPE</td>
<td></td>
<td>Accounts</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>ADDRESS_LABEL</td>
<td></td>
<td>eBusiness Center</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>CODE_STATUS</td>
<td></td>
<td>Persons, organizations, Accounts</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>COMMUNICATION_TYPE</td>
<td></td>
<td>Persons, organizations</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AR</td>
<td>CONTACT_ROLE_TYPE</td>
<td>ADMINISTRATIVE_CONTACT_FOR (Administrative Contact For)</td>
<td>Persons, organizations</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PRESENTMENT_ADMIN (Bill Presentment System Administrator)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PRESENTMENT_CSR (Bill Presentment System Customer Service Representative)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PRESENTMENT_ORG_REP (Bill Presentment System Organization Representative)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PRESENTMENT_SITE_ADMIN (Bill Presentment System Site Administrator)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_TO (Bill To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BUYING_CONTACT_FOR (Buying Contact For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CEO_OF (CEO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CFO_OF (CFO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIO_OF (CIO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTACT (Contact)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CORR (Correspondence)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEPT_HEAD (Department Head)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DUN (Dunning)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EXECUTIVE (Executive)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>KEY_DECISION MAKER_FOR (Key Decision Maker)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL (Legal)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL_CONTACT_FOR (Legal Contact For)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table of Lookups

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>CONTACT_ROLE_TYPE (continued)</td>
<td>MARKET (Market)</td>
<td>Persons, organizations</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MIDDLE_MANAGER (Middle Manager)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRIMARY_CONTACT_FOR (Primary Contact For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RECEIVING_CONTACT_FOR (Receiving Contact For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHIPPING_CONTACT_FOR (Shipping Contact For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHIP_TO (Ship To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STMTS (Statement)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STOCK_HOLDER_OF (Stock Holder)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TECHNICAL_CONTACT_FOR (Technical Contact For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>CONTACT_TITLE</td>
<td>DR (Dr.)</td>
<td>Persons, organizations</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MISS (Miss)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MR (Mr.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MRS (Mrs.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MS (Ms.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SIR (Sir)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>CONTACT_TYPE</td>
<td></td>
<td>Persons, organizations, events, collateral</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>COUNTRY</td>
<td></td>
<td>eBusiness Center, persons, organizations, leads, opportunities, events lookup, scripting</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>CREDIT_RATING</td>
<td></td>
<td>Persons, Organizations</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>CUSTOMER_CATEGORY</td>
<td>CUSTOMER (Customer)</td>
<td>Accounts. persons, organizations</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PROSPECT (Prospect)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>AR</td>
<td>CUSTOMER_TYPE</td>
<td></td>
<td>eBusiness Center</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>DAY</td>
<td></td>
<td>eBusiness Center, persons, organizations, accounts, leads, opportunities, events, collateral, lookup, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>DECISION_FACTOR_TYPE</td>
<td>ACCOUNTING, ADMINISTRATION, CUSTOMER SERVICE, DISTRIBUTION/LOGISTICS, ENGINEERING, FACILITIES, HUMAN RESOURCES, INFORMATION TECHNOLOGY, LEGAL, MANUFACTURING, MARKETING, MERCHANDISING, OPERATIONS, PURCHASING, QUALITY ASSURANCE, R&amp;D (Research &amp; Development), RISK ANALYSIS, SALES, TRAINING</td>
<td>Accounts, Opportunity Contacts, Persons, organizations, lookup</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>DECISION_PRIORITY_TYPE</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>DEPARTMENT_TYPE</td>
<td>ACCOUNTING, ADMINISTRATION, CUSTOMER SERVICE, DISTRIBUTION/LOGISTICS, ENGINEERING, FACILITIES, HUMAN RESOURCES, INFORMATION TECHNOLOGY, LEGAL, MANUFACTURING, MARKETING, MERCHANDISING, OPERATIONS, PURCHASING, QUALITY ASSURANCE, R&amp;D (Research &amp; Development), RISK ANALYSIS, SALES, TRAINING</td>
<td>Persons, organizations, lookup</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>----------------------------</td>
<td>----------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AR</td>
<td>FOLLOW_UP</td>
<td></td>
<td>Opportunities, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>FORM_NAME</td>
<td></td>
<td>eBusiness Center, persons, organizations, leads, quotes/orders, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>INTEREST_TYPE</td>
<td>ENTERTAINMENT</td>
<td>Leads, opportunities, lookup</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HOBBIES</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PREFERENCES</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SPORTS</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRAITS</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>JOB_TITLE_CODE</td>
<td></td>
<td>Persons, Organizations</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>LANGUAGE</td>
<td>ENG (English)</td>
<td>Persons, opportunities, events, lookup, scripting</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FRE (French)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GER (German)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ITA (Italian)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SPA (Spanish)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>MONTH</td>
<td></td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>NOTE_TYPE</td>
<td></td>
<td>eBusiness Center, leads, opportunities, events</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>OWNER_TABLE_NAME</td>
<td></td>
<td>Persons, organizations, opportunities, lookup</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>--------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>AR</td>
<td>PARTY_RELATIONS_TYPE</td>
<td>ADVERTISER (Advertiser)</td>
<td>Persons, Organizations</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AFFILIATE_TO (Affiliate)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AGREEMENT_SIGNER_OF (Party that signs agreement on behalf of another party)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASSOCIATE_OF (Associate of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AUNT (Aunt)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BENEFACCTOR_OF (Benefactor of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BENEFICIARY (Beneficiary)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILLER_AT (When an organization is registered biller)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILLER_FOR (Biller For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILLTO_OF (Alternate billing party for the buyer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_CONSOLIDATOR_AT (Bill consolidator at)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_CONSOLIDATOR_FOR (Bill Consolidator for)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PRESENTER_FOR (Bill Presenter at)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PUBLISHER_AT (Bill publisher at)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_PUBLISHER_FOR (Bill publisher for)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BOARD_MEMBER_OF (Board Member)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BROTHER_OF (Brother)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BUSINESS_PARTNER_FOR (Business partner)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CEO_OF (CEO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CFO_OF (CFO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CHANNEL_FOR (Channel)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CHILD_OF (child of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CIO (CIO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COMPETITOR_OF (Competitor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>--------------------------</td>
<td>------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>PARTY_RELATIONS_TYPE</td>
<td>CONSULTANT_FOR (Consultant)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>(continued)</td>
<td>CONTACT_OF (Contact)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTAINS_MEMBER (Contains member)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COUSIN_OF (Cousin)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CUSTOMER_OF (Customer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DAUGHTER_OF (Daughter)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEPENDENT_OF (Dependent)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DIVISION_OF</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DOMESTIC_PARTNER_OF (Domestic Partner)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DOMESTIC_SUBSIDIARY_OF (Domestic subsidiary of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DOMESTIC_ULTIMATE_OF (Domestic Ultimate of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EMPLOYEE_OF (Employee)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>EMPLOYER_OF (Employer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FATHER_OF (Father of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>FIELD_SERVICE_PROVIDER_FOR (Field Service provider)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GENERAL_EMPLOYEE_OF (General Employee)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GLOBAL_SUBSIDIARY_OF (Global subsidiary of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GLOBAL_ULTIMATE_OF (Global Ultimate of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GUARANTOR_FOR (Guarantor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GUARDIAN_OF (Guardian)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HEADQUARTERS_OF (Headquarters of)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>KEY_DECISION_MAKER_FOR (Key decision maker)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL_COUNSEL_FOR (Legal counsel for)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MANAGER_OF (Manager_of)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Table of Lookups
## Table of Lookups

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>PARTY_SITE_USE_CODE</td>
<td>ACK (Acknowledgments)</td>
<td>Persons, Organizations</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ADMINISTERED_BY (Administered By)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BILL_TO (Bill To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BOL (Bills of Lading)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>BUSINESS (Business)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CM (Credit Memos)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COLLATERAL_MAIL_TO (Collateral Mail To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CORR (Correspondence)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CUSTOMER_REGION (Customer Region)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DELIVER_TO (Deliver To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DRAWEE (Drawee)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DUN (Dunning)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GENERAL_MAIL_TO (General Mail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HEADQUARTERS_FOR (Headquarters for)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HOME (Home)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INCORPORATED_TO (Incorporated)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INSTALL_AT (Install At)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INV (Invoice)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISSUED_BY (Issued By)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>KEY_SITE (Key Site)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL (Legal)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL_ADDRESS_OF (Legal Address)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEGAL_RESIDENCE_OF (Legal Residence)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MARKET (Market)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MARK_FOR (Mark For)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>NOT_ALLOWED_INTO (Not Allowed Into)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFFER_TO (Offer to)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------</td>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>AR</td>
<td>PARTY_SITE_USE_CODE</td>
<td>OTHER (Other)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAYMENT_WILL_BE_MADE_BY (Be Made By)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAY_TO (Pay To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REPLY_TO (Reply To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>REPORT_TO (Report To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RESIDES_AT (Resides At)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHIP_FROM (Ship From)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SHIP_TO (SHIP_TO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOLD_TO (Sold To)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STMTS (Statements)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>STORE (Store)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SUPPORT_SITE (Support Site)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORKS_AT (Works At)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WORK_PERFORMED_AT (Work Performed At)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>PARTY_TYPE</td>
<td></td>
<td>eBusiness Center, persons,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>organizations, accounts, leads,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>opportunities, quotes/orders,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>events, collateral</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>PAYMENT_TYPE</td>
<td></td>
<td>Events</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>----------------------</td>
<td>--------</td>
<td>----------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AR</td>
<td>PHONE_LINE_TYPE</td>
<td>FAX (Fax)</td>
<td>Persons, organizations, opportunities</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GEN (General)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>IW (Inbound watts)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OW (Outbound watts)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>VM (Voice mail)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ASSISTANT (Assistant)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>HOME (Home)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>MOBILE (Mobile)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>OFFICE (Office)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PAGER (Pager)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>PREFERENCES</td>
<td>eBusiness Center</td>
<td>Persons, organizations, leads, opportunities, events, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>REASON</td>
<td>Persons, organizations, leads, opportunities, events, Universal Work Queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>REFERENCE</td>
<td>eBusiness Center</td>
<td>Persons, organizations, accounts, leads, opportunities, lookup, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>REFERENCE</td>
<td>Persons, organizations, leads, opportunities, lookup, Universal Work Queue</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>RELATIONSHIP_TYPE</td>
<td>Persons, organizations, lookup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>REMIT</td>
<td>Persons, organizations</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table of Lookups

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>AR</td>
<td>RESPONSIBILITY</td>
<td>APC (Accounts Payable Clerk)</td>
<td>Persons, organizations, Universal Work Queue</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>APS (Accounts Payable Supervisor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ARC (Accounts Receivable)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ARS (Accounts Receivable Supervisor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CFO (Chief Financial Officer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COLCT (Collections)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>COLCTSUP (Collections Supervisor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTRLR (Controller)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GLC (General Ledger Clerk)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>GLS (General Ledger Supervisor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOC (Sales Operation Clerk)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SOS (Sales Operations Supervisor)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRSUR (Treasurer)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>ROLE_LEVEL</td>
<td></td>
<td>Persons, organizations</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>SELECT_TYPE</td>
<td></td>
<td>Persons, organizations</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>SITE_USE_CODE</td>
<td></td>
<td>Persons, Organizations</td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>STATE</td>
<td>AK</td>
<td>eBusiness Center, persons, organizations, leads, opportunities, collateral, lookup, scripting, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AR</td>
<td>SUBJECT_TABLE</td>
<td></td>
<td>Persons, organizations</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>ACCESS_PRIVILEGE</td>
<td>F (Full unrestricted access)</td>
<td>Access privilege for employee</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>P (Prospecting Access)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>T (Sales Team Access)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AS</td>
<td>ASTATA_RUN_MODE</td>
<td>New (Run program in new mode)</td>
<td>Run mode for Territory Assignment concurrent program</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Restart (Run program after new mode aborted)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Total (Run program in total mode to refresh all access records)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>AUTO_ASSIGNMENT_TYPE</td>
<td>Both</td>
<td>Automatic assignment type</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>None</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>PRM</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TAP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>BUDGET_AMOUNT</td>
<td>Leads, lookup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>BUDGET_STATUS</td>
<td>Leads, lookup</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>CLOSE_REASON</td>
<td>Leads, opportunities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>CLOSE_REASON</td>
<td>A (Availability)</td>
<td>Opportunity close reason</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>C (Competition)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>F (Function)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>P (Price)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>S (Service)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>CONTACT_RANK_ON_OPPORTUNITY</td>
<td>DECISION_MAKER</td>
<td>Opportunity contact rank</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>END_USER</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>DECISION_TIMEFRAME</td>
<td>Leads</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>FLAG</td>
<td>N (No)</td>
<td>Flag</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Y (Yes)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>INTEREST_USE</td>
<td>COMPANY_CLASSIFICATION (Customer Classification)</td>
<td>Interest use</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CONTACT_INTEREST (Contact Interest)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>LEAD_CLASSIFICATION (Lead or Opportunity Classification)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>INTEREST_USE</td>
<td>Opportunities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>ISSUE</td>
<td>eBusiness Center, leads, opportunities</td>
<td></td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>------------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AS</td>
<td>LEAD_CONTACT_ROLE</td>
<td></td>
<td>Leads</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>LEAD_SOURCE</td>
<td></td>
<td>Leads,</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>MC_DATE_MAPPING_TYPE</td>
<td>E (End date of a period)</td>
<td>Date mapping</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>S (Start date of a period)</td>
<td>type</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>METHODOLOGY_TYPE</td>
<td>OOP (Object Oriented)</td>
<td>Opportunity</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>methodology</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>OPP_ACCESS_PRIVILEGE</td>
<td>F (Full Unrestricted Access)</td>
<td>Opportunity</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>O (Full Access by Operating Unit)</td>
<td>access privilege</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>P (Prospecting Access)</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>T (Sales Team Access)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>OPP_PROBABILITY_LINK</td>
<td>Error (New value is not acceptable)</td>
<td>Opportunity</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Warning (Warn user about error)</td>
<td>probability</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>links</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>PLAN_ELEMENT_MAPPING</td>
<td>PCODE (Map quota to primary</td>
<td>Sales categories</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>interest code)</td>
<td>mapping with</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SCODE (Map quota to secondary</td>
<td>sales quotas</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>interest code)</td>
<td>(Oracle</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TYPE (Map quota to interest type)</td>
<td>Incentive</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Compensation</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>PRM_LEAD_TYPE</td>
<td>ASSIGN_ERROR</td>
<td>Opportunities</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>REJECT_REASON_CODE</td>
<td>DUPLICATE</td>
<td>Leads</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>ROLE_TYPE</td>
<td>VACATION</td>
<td>Persons,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Organizations,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>accounts,</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>lookup</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>ROLE_TYPE</td>
<td>AM (Account Manager)</td>
<td>Role type</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>PS (Product Specialist)</td>
<td>U</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>SALESFORCE_RELATIONSHIP</td>
<td></td>
<td>Opportunities</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>SCD_REFRESH_MODE</td>
<td>1 (Complete refresh)</td>
<td>Sales Credit</td>
<td>U</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Incremental refresh)</td>
<td>Denorm refresh mode</td>
<td></td>
</tr>
<tr>
<td>App.</td>
<td>Lookup Type</td>
<td>Values</td>
<td>Affects</td>
<td>Level</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------</td>
<td>-------------------------</td>
<td>--------------------</td>
<td>-------</td>
</tr>
<tr>
<td>AS</td>
<td>SCD_RUN_MODE</td>
<td>1 (Complete)</td>
<td>Sales Credit</td>
<td>E</td>
</tr>
<tr>
<td></td>
<td></td>
<td>2 (Update)</td>
<td>Denorm run mode</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>UPDATE_ACCESS</td>
<td></td>
<td>eBusiness Center</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>UPDATE_ACCESS</td>
<td>I (Inherit data)</td>
<td>Update access</td>
<td>S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>R (View data)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>U (Update subordinate’s data)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>VEHICLE_RESPONSE_CODE</td>
<td></td>
<td>Leads</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>VEHICLE_RESPONSE_CODE</td>
<td></td>
<td>Opportunities</td>
<td></td>
</tr>
<tr>
<td>AS</td>
<td>VEHICLE_RESPONSE_CODE</td>
<td></td>
<td>Lookup</td>
<td></td>
</tr>
<tr>
<td>ASO</td>
<td>ASO_ITEM_TYPE</td>
<td></td>
<td>Accounts</td>
<td></td>
</tr>
<tr>
<td>ASO</td>
<td>ASO_QUOTERELATEDOBJECTS</td>
<td></td>
<td>Quotes/Orders</td>
<td></td>
</tr>
<tr>
<td>JTF</td>
<td>ACTION_TYPE</td>
<td>ADD</td>
<td>Events, Universal Work Queue</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>ANSWER</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CREATE_FSR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>DEL</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INQ</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>INTERACT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RECONCILE</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>SENT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>TRANSFER</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UPD</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UPDATE_FSR</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UPSELL</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WAIT</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>XSELL</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JTF</td>
<td>ROLE_TYPE</td>
<td></td>
<td>Sales Team</td>
<td></td>
</tr>
</tbody>
</table>
### Table of Lookups

<table>
<thead>
<tr>
<th>App.</th>
<th>Lookup Type</th>
<th>Values</th>
<th>Affects</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>OTS</td>
<td>Quick Find Types</td>
<td>Account Number</td>
<td>eBusiness Center: Quick Search field</td>
<td>User</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Service Request Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Service Key</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Telephone Number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Organization number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Person number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Relationship number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tax ID</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Quote number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Order number</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contract number</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>